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PREFACE

As part of an effort to improve the product lines, revisions of the software and
hardware are periodically released. Therefore, some functions that are described in
this document might not be supported by all versions of the software or hardware
currently in use. The product release notes provide the most up-to-date information
on product features.

Contact the technical support professional when a product does not function correctly
or does not function as described in this document.

Note

This document was accurate at publication time. To find the latest version of this
document, go to Online Support (https://support.EMC.com).

Purpose
This guide describes how to install, configure, administer, and use the
Dell EMC Avamar™ Plug-in for Lotus™ Domino™.

Audience
This document is intended for use by the following users:

l System administrators, who are responsible for installing software and maintaining
servers and clients on a network.

l IBM Lotus Domino administrators, who are responsible for backing up and
maintaining Domino servers.

Revision history
The following table presents the revision history of this document.

Revision Date Description

01 February 1, 2018 GA release of Avamar 7.5.1

Related documentation
The following Dell EMC publications provide additional information:

l Avamar Administration Guide

l Avamar Compatibility and Interoperability Matrix

l Avamar Operational Best Practices Guide

l Avamar Release Notes

Avamar for Lotus Domino 7.5.1  User Guide 11

https://support.emc.com/


Special notice conventions used in this document
These conventions are used for special notices.

DANGER

Indicates a hazardous situation which, if not avoided, results in death or serious
injury.

WARNING

Indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION

Indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

Addresses practices that are not related to personal injury.

Note

Presents information that is important, but not hazard-related.

Typographical conventions
These type style conventions are used in this document.

Table 1 Typographical conventions

Bold Used for names of interface elements, such as names of windows,
dialog boxes, buttons, fields, tab names, key names, and menu paths
(what the user specifically selects or clicks)

Italic Used for full titles of publications that are referenced in text

Monospace Used for:

l System code

l System output, such as an error message or script

l Pathnames, filenames, prompts, and syntax

l Commands and options

Monospace italic Used for variables

Monospace bold Used for user input

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces enclose content that the user must specify, such as x or y or
z

... Ellipses indicate nonessential information that is omitted from the
example

PREFACE
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Where to get help
The Avamar support page provides access to licensing information, product
documentation, advisories, and downloads, as well as how-to and troubleshooting
information. This information may resolve a product issue before contacting Customer
Support.

To access the Avamar support page:

1. Go to https://support.EMC.com/products.

2. Type a product name in the Find a Product by Name box.

3. Select the product from the list that appears.

4. Click the arrow next to the Find a Product by Name box.

5. (Optional) Add the product to the My Products list by clicking Add to My Saved
Products in the upper right corner of the Support by Product page.

Comments and suggestions
Comments and suggestions help to continue to improve the accuracy, organization,
and overall quality of the user publications. Send comments and suggestions about
this document to DPAD.Doc.Feedback@emc.com.

Please include the following information:

l Product name and version

l Document name, part number, and revision (for example, 01)

l Page numbers

l Other details to help address documentation issues

PREFACE
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CHAPTER 1

Introduction

This chapter includes the following topics:

l Architecture....................................................................................................... 16
l Backup...............................................................................................................20
l Restore...............................................................................................................21
l Concurrent backups and restores...................................................................... 22
l DAOS support.................................................................................................... 23
l Internationalization (I18N) support.....................................................................23
l Multi-streaming..................................................................................................24
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Architecture
The Avamar

®
 Plug-in for Lotus Domino works with the Domino server to back up

Domino data to an Avamar server or a Data Domain
®

 system. The Avamar Plug-in for
Lotus Domino serves as a backup module and the Avamar server or Data Domain
system as a storage device.

The Avamar Plug-in for Lotus Domino supports the Domino server in both stand-alone
configurations and clustered configurations. The Avamar Plug-in for Lotus Domino
does not support local databases of Notes clients.

IBM Lotus Domino supports the use of DB2 databases as a data repository for Domino
databases. The Avamar Plug-in for Lotus Domino, however, does not support this type
of configuration.

Data Domain support
The Avamar Plug-in for Lotus Domino supports backups to and restores from Data
Domain systems. You can back up Domino data to a Data Domain system by using
Avamar Administrator or by using the command line interface. Metadata for the
backup is stored on the Avamar server.

Restore backed up data from a Data Domain system the same way you restore data
from the Avamar server. Follow the same restore procedure whether the data is on
the Avamar server or a Data Domain system.

The Avamar and Data Domain System Integration Guide provides more information about
configuring Data Domain systems for use with Avamar systems.

Stand-alone configurations
In a stand-alone configuration, one computer runs the Avamar client software and the
Domino server software.

In a stand-alone environment, the Domino server host requires the installation of the
following software:

l Domino server that is supported by Avamar

l Platform-specific Avamar client software

l Avamar Plug-in for Lotus Domino

The following figure shows a stand-alone configuration in which the Avamar Plug-in
for Lotus Domino saves data to an Avamar server.

Introduction
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Figure 1 Avamar Plug-in for Lotus Domino stand-alone configuration

Cluster configurations
The Avamar Plug-in for Lotus Domino supports Lotus Domino servers in two-node
active/passive or active/active Microsoft Windows cluster configurations.

For a Windows cluster environment, install the following software on each Domino
server:

l Avamar Client for Windows

l Avamar Plug-in for Lotus Domino

l Avamar Cluster Client

Install the Avamar Cluster Client only on the active node. Installation and
Configuration on page 25 provides more information about installing the software in
a Windows cluster.

The following figure shows the Avamar Plug-in for Lotus Domino in an active/passive
cluster configuration.

Introduction
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Figure 2 Avamar Plug-in for Lotus Domino cluster configuration

Two-node active/passive cluster deployment
In a two-node active/passive cluster, the active node runs applications while the
passive node stands ready to take over if the active node fails.

When a failure occurs on the active node, its applications, such as the Domino server
and Avamar client, fail over to the passive node. If scheduled Avamar backups exist for
the active node, the passive node runs them while the active node is offline. Once the
active node comes back online, the passive node fails back the Domino server and the
Avamar client applications to the active node. Then the passive node goes back into
standby mode.

Two-node active/active cluster deployment
In a two-node active/active cluster, both nodes are active and run applications.

If an active node (for example, NODE-1) fails, its applications fail over to the second
active node (for example, NODE-2). NODE-2 now runs its own applications plus the
ones from NODE-1. If, for example, scheduled Avamar backups exist for NODE-1,
NODE-2 must run them while NODE-1 (the failed node) is offline. Once NODE-1
comes back online, NODE-2 fails back the applications, such as the Domino server and
Avamar client, to NODE-1.

To use Lotus Domino in an active/active Windows cluster requires a Domino
partitioned server.

Introduction
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Multiple versions of Domino on a single host
On UNIX, the Avamar Plug-in for Lotus Domino supports multiple installations of the
Domino server. The Domino server versions can be the same or different.

On 64-bit AIX, the Avamar Plug-in for Lotus Domino supports the coexistence of both
32-bit and 64-bit versions of the Domino server on the same host. The Avamar Plug-in
for Lotus Domino installation package for AIX includes both the 32-bit and 64-bit plug-
in software.

Note

IBM does not support multiple versions of the Domino server on Windows platforms.

Types of files backed up and restored
The Avamar Plug-in for Lotus Domino backs up and restores database files, non-
database files such as ID files, the notes.ini file, and transaction logs.

The following table describes the four types of database files that the Avamar Plug-in
for Lotus Domino backs up.

Table 2 Types of database files

Database file extensions Description

.NSF .NSF files comprise two types:

l Lotus Notes database files, which contain
email for users.

l Lotus Notes database link files, which
contain a link to a Lotus Notes database
in a directory other than the data
directory.

.NTF Template files for creating Notes applications
and system databases.

.box Outgoing email messages.

.dir Lotus directory links. These files contain the
full pathname to the directory outside of the
data directory.

Lotus Domino stores all Lotus Notes client files and Domino server files in the data
directory in the installation directory:

l On Windows, the default installation directory is C:\Program Files\IBM
\Lotus\Domino\data.

l On AIX, Linux, or UNIX, the default installation directory is /local/notesdata.

You can also store Notes client files and Domino server files in an alternate location by
using database and directory links.

Introduction
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Client cache and log files
The Avamar Plug-in for Lotus Domino creates client cache files and log files during
backup operations.

The installation of release 7.0 and later of the Avamar Plug-in for Lotus Domino
creates client cache files in /install_path/var/clientlogs. Before release 7.0,
client cache file was installed in /install_path/var.

Backup and restore operations from Avamar Administrator create the avlotus.log
file in the /install_path/var/clientlogs directory.

Backup
The Avamar Plug-in for Lotus Domino enables you to perform both hot and cold
backups. During a hot backup, databases are online and accessible. During a cold
backup, databases are offline.

Backup types
The Avamar Plug-in for Lotus Domino enables you to perform full, incremental, and
subset backups.

The following table describes these types of backups.

Table 3 Types of backups

Backup types Description

Full Backs up all database files on the Domino
server whether they have changed since the
last backup. Optionally, a full backup backs up
transaction logs if you enable transaction
logging and set logging style to Archived. A

full backup also archives the transaction logs
if you include transaction logs in the backup.
Lotus Domino documentation provides more
information about transaction logging.

Incremental Backs up the following items:

l All transaction logs on the Domino server.

l All new databases that you created since
the last full or incremental backup.

l All databases in which the DBIID property
changed since the last full or incremental
backup.

The Avamar Plug-in for Lotus Domino
supports incremental backups only when you
set transaction logging to Archived. You

must run a full backup before you run the first
incremental backup.

Subset Backs up all selected database files. A subset
backup never backs up the transaction logs. If

Introduction
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Table 3 Types of backups  (continued)

Backup types Description

you select either the Backup transaction
logs with full backup or the Archive
transaction logs option in the Backup
Command Line Options dialog box, the
backup ignores the option.

Backups of Domino partitioned servers
The Avamar Plug-in for Lotus Domino supports both manual and scheduled backups of
Domino partitions.

Domino partitions share the same Domino program directory. Each partition has its
own data directory and notes.ini file. Back up each partition separately. The
backup procedure is similar to the backup procedure for a single Domino server. For
each partition, provide the full pathname to the notes.ini file and the full pathname
to the Domino directory. Backup on page 45 provides more information about
backing up the Domino server.

Transaction log backups
The Avamar Plug-in for Lotus Domino supports backups of the transaction logs.

Because Lotus Domino typically stores the transaction logs on a separate disk, the
Avamar Plug-in for Lotus Domino can back up the transaction logs in parallel with
other data streams during both full and incremental backups. After the Avamar Plug-in
for Lotus Domino backs up all data files, the plug-in backs up the remaining
transaction logs.

Incremental backups fail if you set transaction logging to circular or linear. The Avamar
Plug-in for Lotus Domino supports incremental backup only when you set transaction
logging to Archived on the Domino server.

Restore
The Avamar Plug-in for Lotus Domino supports restores from the original client to the
same target location or to a different target location.

The Avamar Plug-in for Lotus Domino supports restores to the following targets:

l Original client in the original directory

l Original client in a different directory

l Different client

The destination client must run the same operating system and the same or later
version of Domino server as the original client.

Redirected restores
The Avamar Plug-in for Lotus Domino supports redirected restores. A redirected
restore enables you to restore a database to the destination host, which must be on

Introduction
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the same type of a computer as the original host. The Avamar Plug-in for Lotus
Domino does not support cross-platform restores.

The destination host can run a different version of the operating system or Domino
server than the original host. The Avamar file system client and the Domino server
must support the versions of the two operating systems.

To restore Domino database files to a different directory, the target directory must
have read and write permissions for the specific Domino user account.

Note

The Avamar Plug-in for Lotus Domino uses the user account (by default, “notes”) for
tasks such as starting and stopping the Domino server. Only UNIX systems use the
notes user account.

A restore fails if the target directory does not have read and write permissions for the
Domino user account. Restoring database files to a different directory on page 62
provides more information about restoring Domino database files to different
directories.

When you restore a database from one Domino server to another on the same host or
a different host, you cannot apply the logs. When you restore databases to a new host
and a new Domino server, you can move and apply the logs.

After a redirected restore to a new computer, you cannot apply the transaction logs to
the database because the logs are not available from the new client computer. An
attempt to recover a logged database fails, in which you cannot bring the database
online. This limitation applies to redirected restores of Domino to a target computer
that is part of a cluster or a target computer that participates as a replication server.

Restore of online database
During a restore, the Avamar Plug-in for Lotus Domino takes a database offline,
deletes it, and then restores it with the backup file.

Domino considers each .nsf or .ntf file a separate database. A Domino server can
include hundreds of databases.

Before restoring an online database, ensure that the database is not in use.

Concurrent backups and restores
The Avamar Plug-in for Lotus Domino supports a maximum of six concurrent backups,
restores, or both types of operations from Avamar Administrator.

When six operations are running concurrently and you start a seventh one, the Avamar
Plug-in for Lotus Domino adds the seventh operation to a wait queue. After one of the
running operations completes, the next one in the wait queue starts.

The Avamar Plug-in for Lotus Domino enables you to run concurrent backup and
restore operations for multiple partitions in a partitioned Domino environment or when
you install multiple Domino servers on same host.

Concurrent operations require additional system resources such as memory and CPU.
Consider the resource impact on the system before running concurrent operations.

Concurrent operations must reference different instances. You cannot run concurrent
operations for the same instance.

Introduction
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DAOS support
Lotus Domino 8.5 includes the Domino Attachment and Object Storage (DAOS)
feature.

The Avamar Plug-in for Lotus Domino supports the backup and restore of databases
on DAOS-enabled servers. Enabling DAOS on a Domino server reduces disk space
usage. For example, when you send an attachment to multiple users multiple times,
the Domino server stores one copy of the attachment. The Avamar Plug-in for Lotus
Domino backs up the attachment once.

Backups of DAOS-enabled servers
To back up a database on a DAOS-enabled server, the Avamar Plug-in for Lotus
Domino backs up the database and the DAOS directory.

The Avamar Plug-in for Lotus Domino automatically backs up the DAOS directory for
all types of backups: full, incremental, and subset. You do not need to include the
DAOS directory in the backup request. The Avamar Plug-in for Lotus Domino backs up
the DAOS directory after the backup of the data files and the transaction logs.

Restores to DAOS-enabled servers
During a restore operation of a DAOS-enabled database, the Avamar Plug-in for Lotus
Domino checks for missing attachments (NLO files), restores them, and then
synchronizes the DAOS catalog by using the daosmgr executable.

The Avamar Plug-in for Lotus Domino does not support a redirected restore of a
DAOS-enabled database to a different computer. You cannot move a DAOS-enabled
database from one computer to another because references to all attachments are to
the original server.

An attempt to restore a DAOS-enabled database to a new computer restores the
database. The attachments in the NLO files are not accessible. The NLO files are
inaccessible regardless of whether you select the Restore missing NLO files option
from Avamar Administrator.

This limitation applies to redirected restores of Domino to a destination computer that
is part of a cluster or a destination computer that is a replication server.

Internationalization (I18N) support
Internationalization (I18N) support enables you to browse, back up, monitor, and
restore non-English data from Avamar clients without localizing the software.

The Avamar Plug-in for Lotus Domino can back up and restore Domino databases and
files that are named with international characters encoded with UTF-8 (UCS
Transformation Format–8-bit) on Linux and UNIX, and UTF-16 on Windows.

Note

Do not confuse I18N support with localization (L10N) support. L10N translates the
software user interface and operational messages into localized languages. This
release of the Avamar Plug-in for Lotus Domino does not provide L10N support.
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Multi-streaming
Multiple backup streams enable the Avamar Plug-in for Lotus Domino to back up the
Domino files and the transaction logs in parallel streams. The Avamar Plug-in for Lotus
Domino supports multiple backup and restore streams.

Multiple backup streams can improve the rate at which the Avamar Plug-in for Lotus
Domino writes data to the Avamar server or the Data Domain system. The Avamar
Plug-in for Lotus Domino balances the backup data among the available streams which
are based on total size or logical volumes.

Data backed up in size-based streams occur in the following order:

1. Data files using multiple parallel streams.

2. Transaction logs using multiple parallel streams.

3. DAOS directory using a single stream.

Multi-stream backups of logical volume-based data use separate streams to back up
each volume. Transaction logs that are on a separate volume from the data use a
single stream.

Data backed up in volume-based streams occur in the following order:

1. Data files using multiple parallel streams.

2. Transaction logs that are on a separate volume from the data using a single
stream.

3. DAOS directory using a single stream.

The Avamar Plug-in for Lotus Domino merges all backups from multiple streams into
one image at the end of the backup operation.

A restore operation uses the same stream content and number of streams as the
corresponding backup. A multi-stream restore process can improve performance
because the number of avtar processes are reduced in comparison to single-stream
restores, which run sequentially.

The maximum number of streams for either a backup or restore is 10 and the default is
1.
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CHAPTER 2

Installation and Configuration

This chapter includes the following topics:

l Preparing to install the Avamar Plug-in for Lotus Domino.................................. 26
l Installing, upgrading, and uninstalling on IBM AIX.............................................. 28
l Installing, upgrading, and uninstalling on RHEL...................................................31
l Installing, upgrading, and uninstalling on SLES...................................................33
l Installing, upgrading, and uninstalling on Solaris.................................................36
l Installing, upgrading, and uninstalling on Windows............................................. 38
l Performing post-installation tasks......................................................................44
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Preparing to install the Avamar Plug-in for Lotus Domino
Review the system requirements for the Avamar Plug-in for Lotus Domino to ensure
that the environment meets these requirements before you perform the installation.
Download the Avamar file system client and Avamar Plug-in for Lotus Domino
installation packages from the Avamar server.

System requirements
Before you install the Avamar Plug-in for Lotus Domino, ensure that you meet all
software and hardware requirements.

The Avamar file system client and the Avamar Plug-in for Lotus Domino that are
installed on the host must be the same version number. You can install the Avamar
Plug-in for Lotus Domino on 32-bit or 64-bit platforms.

Client compatibility requirements are available in the Avamar Compatibility and
Interoperability Matrix at http://compatibilityguide.emc.com:8080/CompGuideApp.
The requirements in the matrix include supported operating systems and application
versions.

Domino server requirements
The Domino server requirements include setting ARCHIVE mode (transaction logging)
and setting the BACKUP_TIMEOUT parameter.

Changing Domino server configuration settings might require two Domino server
restarts or a reboot of the system that runs the Domino server for the configuration
changes to take effect. The IBM Lotus Domino technote 1381136 provides more
information.

Setting ARCHIVE mode on the Domino server
You must set databases on the Domino server to archive logging to perform
incremental backups with the Avamar Plug-in for Lotus Domino.

Incremental backups fail if you enable circular or linear logging for the database on the
Domino server.

Procedure

1. Log in to the Domino server.

2. Set transaction logging to Archived.

The Lotus Domino documentation provides additional instructions.

Setting the BACKUP_TIMEOUT parameter in notes.ini
Set a timeout value for the BACKUP_TIMEOUT parameter to an adequate value to
avoid any possible backup failure.

You can prevent a backup from timing out by setting the BACKUP_NO_TIMEOUT
parameter to 1 instead of setting the BACKUP_TIMEOUT parameter to 60 minutes. The
use of the BACKUP_NO_TIMEOUT parameter can result in a backup that runs
continuously. Use only one of these parameters in the notes.ini file.

Procedure

1. Log in to the Domino server.
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2. Open the \path\notes.ini file in a text editor. Specify the full directory
pathname to the notes.ini file for path.

3. Set the BACKUP_TIMEOUT parameter in the notes.ini file to 60 minutes:

BACKUP_TIMEOUT=60

The default value for BACKUP_TIMEOUT is 15 minutes even if the parameter
does not exist in the notes.ini file.

4. Save the changes and close the text editor.

5. Restart the Domino server twice for the configuration change to begin.

Downloading the software
Download the installation packages for the Avamar Plug-in for Lotus Domino from the
Avamar server, and then save the package to a temporary directory.

The Avamar Plug-in for Lotus Domino installation package for a Linux 64-bit system is
available from the Linux for x86 (32 bit) platform heading on the Downloads web
page. Use AvamarLotus-linux-rhel4-x86-7.2.100-build.rpm or
AvamarLotus-linux-sles11-x86-7.2.100-build.rpm to install the Avamar
Plug-in for Lotus Domino on a Linux 64-bit system.

Procedure

1. Log in to the Domino server host with the necessary privileges to perform an
installation.

2. Open a web browser and type the following URL:

https://Avamar_server

where Avamar_server is the DNS name or IP address of the Avamar server.

The Avamar Web Restore page appears.

3. Click Downloads.

The Downloads list appears.

4. Click + next to the platform heading for the Domino server.

5. Click + next to the operating system heading for the Domino server.

6. Click the link for the Avamar Plug-in for Lotus Domino installation package.

7. Save the Avamar Plug-in for Lotus Domino installation package to a temporary
directory.

Installing the Avamar file system client
Install the appropriate Avamar file system client before installing the Avamar Plug-in
for Lotus Domino.

Procedure

l For IBM AIX, RHEL, SLES, and Solaris systems, follow the instructions in the
Avamar Backup Clients User Guide.

l For Windows systems, follow the instructions in the Avamar for Windows Server
User Guide.
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Installing RHEL6 or RHEL7 64-bit packages
The Avamar Plug-in for Lotus Domino on RHEL6 or RHEL7 64-bit systems requires
additional software to enable the browse feature.

Software packages for RHEL6 and RHEL7 64-bit systems are available in the
Packages folder from the RHEL 6 or RHEL 7 installation ISO image or DVD.

Procedure

l To enable the browse feature for the Avamar Plug-in for Lotus Domino on RHEL6
and RHEL7 64-bit systems, install the following packages:

Table 4 RHEL6 and RHEL7 64-bit packages

RHEL6 RHEL7

n libcap-2.16-5.2.el6.i686.rpm
n libxml2-2.7.6-1.el6.i686.rpm
n libacl-2.2.49-4.el6.i686.rpm
n zlib-1.2.3-25.el6.i686.rpm

n libcap-2.22-8.el7.i686.rpm
n libxml2-2.9.1-5.el7.i686.rpm
n libacl-2.2.51-12.el7.i686.rpm
n zlib-1.2.7-13.el7.i686.rpm

Installing, upgrading, and uninstalling on IBM AIX
You can install, upgrade, and uninstall the Avamar Plug-in for Lotus Domino on IBM
AIX.

Installing the Avamar Plug-in for Lotus Domino on IBM AIX
The Avamar Plug-in for Lotus Domino installation package for AIX includes both the
32-bit and 64-bit plug-in software. You can install the Avamar Client for AIX software
in either the default installation directory or an alternate directory. Use the
geninstall command to install the Avamar Plug-in for Lotus Domino in the default
var directory or use the installp command to install the Avamar Plug-in for Lotus
Domino in a new location.

Ensure that you install the Avamar Plug-in for Lotus Domino in the same directory as
the Avamar Client for AIX. The installation returns an error if you install the Avamar
Plug-in for Lotus Domino in default directory after you install the Avamar Client for
AIX in an alternate directory.

Procedure

1. Log in to the Domino server as root.

2. Change the directory to the temporary directory by typing the following
command:

cd /tmp

where tmp is the temporary install directory.

3. To install the Avamar Plug-in for Lotus Domino in the default directory, type the
following command:

geninstall -d /tmp/AvamarLotus-platform-version.bff all
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where:

l platform is the AIX system type. For example: aix6-ppc or aix6-ppc64.

l version is the Avamar software version.

4. To install the Avamar Plug-in for Lotus Domino in an alternate directory, type
the following command:

installp -R /install_path -d AvamarLotus-platform-version.bff
all

where:

l install_path is the directory for the installation files.

l platform is the AIX system type. For example: aix6-ppc or aix6-ppc64.

l version is the Avamar software version.

Upgrading the Avamar Plug-in for Lotus Domino on IBM AIX
Upgrade the Avamar Plug-in for Lotus Domino before upgrading the Avamar Client for
AIX. The Avamar Client for AIX and Avamar Plug-in for Lotus Domino must be the
same version.

Procedure

1. Download the Avamar Plug-in for Lotus Domino installation packages. 
Downloading the software on page 27 provides instructions.

2. Log in to the Domino server as root.

3. Change the directory to the temporary directory by typing the following
command:

cd /tmp

where tmp is the temporary install directory.

4. To upgrade the Avamar Plug-in for Lotus Domino in the default installation
directory, type the following command:

geninstall -d AvamarLotus-platform-version.bff all

where platform-version is the platform type and Avamar version number.

Note

To upgrade the Avamar Plug-in for Lotus Domino in an alternate installation
directory, skip this step and continue to the next step.

5. To upgrade the Avamar Plug-in for Lotus Domino in an alternate installation
directory, type the following command:

installp -R /install_path -d AvamarLotus-platform-version.bff
all

where:

l install_path is the alternate installation directory.
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l platform-version is the platform type and Avamar version number.

6. Download the Avamar Client for AIX. The Avamar Backup Clients User Guide
provides instructions.

7. To upgrade the Avamar Client for AIX in the default installation directory, type
the following command:

geninstall -d AvamarClient-platform-version.bff all

where platform-version is the platform type and Avamar version number.

Note

To upgrade the Avamar Client for AIX in an alternate installation directory, skip
this step and continue to the next step.

8. To upgrade the Avamar Client for AIX in an alternate installation directory, type
the following command:

installp -R /install_path -d AvamarClient-platform-version.bff
all

where:

l install_path is the alternate installation directory.

l platform-version is the platform type and Avamar version number.

Uninstalling the Avamar Plug-in for Lotus Domino on IBM AIX
You can uninstall the Avamar Plug-in for Lotus Domino from an IBM AIX system by
using the geninstall -u command.

When you uninstall the Avamar Plug-in for Lotus Domino and the Avamar Client for
AIX from the host system, scheduled backups no longer occur for the client. You
cannot restore backups to the client after you uninstall the software.

You can retire or delete a client either before or after you uninstall the Avamar Plug-in
for Lotus Domino:

l To keep the backups for the client so that you can restore the backups to a
different client, retire the client by using Avamar Administrator.

l To delete the backups for the client, delete the client by using Avamar
Administrator.

The Avamar Administration Guide provides more information.

Procedure

1. Open a command shell and log in to the Domino server as root.

2. To list Avamar packages that are installed in the default directory, type the
following command:

lslpp -la | grep Avamar

Note

To list Avamar packages that are installed in an alternate installation directory,
skip this step and continue to the next step.

Installation and Configuration

30 Avamar for Lotus Domino 7.5.1  User Guide



3. To list Avamar packages that are installed in an alternate installation directory,
type the following command:

lslpp -la -R /install_path | grep Avamar

where install_path is the alternate installation directory.

4. Uninstall the Avamar Plug-in for Lotus Domino by typing the following
command:

geninstall -u AvamarLotus-platform

where platform is the AIX system type. For example: aix6-ppc or aix6-ppc64.

5. Uninstall the Avamar Client for AIX by typing the following command:

geninstall -u AvamarClient-platform

where platform is the AIX system type. For example: aix6-ppc or aix6-ppc64

Installing, upgrading, and uninstalling on RHEL
You can install, upgrade, and uninstall the Avamar Plug-in for Lotus Domino on RHEL.

Installing the Avamar Plug-in for Lotus Domino on RHEL
You can install the Avamar Client for Linux software in either the default installation
directory or an alternate directory.

Ensure that you install the Avamar Plug-in for Lotus Domino in the same directory as
the Avamar Client for Linux.

Procedure

1. Log in to the Domino server as root.

2. Change the directory to the temporary directory by typing the following
command:

cd /tmp

where tmp is the temporary install directory.

3. To install the Avamar Plug-in for Lotus Domino in the default directory, type the
following command:

rpm -ivh AvamarLotus-linux-platform-version.rpm

where platform-version is the platform type and Avamar version number.

Note

To install the Avamar Plug-in for Lotus Domino in an alternate directory, skip
this step and continue to the next step.

4. To change the base directory for the installation, type the following command:

rpm --relocate /usr/local/avamar=/new_path -i AvamarLotus-linux-
platform-version.rpm

where:

l new_path is the new directory.
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l platform-version is the platform type and Avamar version number.

Note

To change the base directory and the var directory, skip this step and continue
to the next step.

5. To change the base directory and var directory locations during the
installation, type the following command:

rpm -ivh --relocate /usr/local/avamar=base_path --relocate /var/
avamar=var_path AvamarLotus-linux-platform-version.rpm

Upgrading the Avamar Plug-in for Lotus Domino on RHEL
Upgrade the Avamar Plug-in for Lotus Domino by using the rpm -Uvh command. You
can use the --relocate option to specify the alternate installation or var directory
that you specified when you installed the initial version. The versions of the Avamar
Client for Linux and Avamar Plug-in for Lotus Domino must be the same.

Procedure

1. Upgrade the Avamar Client for Linux by using the instructions in the Avamar
Backup Clients User Guide.

2. Change the directory to the temporary directory by typing the following
command:

cd /tmp

3. To upgrade the software in the default directory, type the following command:

rpm -Uvh AvamarLotus-linux-platform-version.rpm

where platform-version is the platform type and Avamar version number.

Note

To upgrade the software in a nondefault installation directory, skip this step and
continue to the next step.

4. To upgrade the software in a nondefault installation directory, type the
following command:

rpm -Uvh --relocate /usr/local/avamar=install_path AvamarLotus-
linux-platform-version.rpm

where:

l install_path is the installation directory that you specified when you installed
the earlier version of the Avamar Plug-in for Lotus Domino software.

l platform-version is the platform type and Avamar version number.

Note

To upgrade the software and use a nondefault var directory, skip this step and
continue to the next step.

5. To upgrade the software and use a nondefault var directory, type the following
command:

Installation and Configuration

32 Avamar for Lotus Domino 7.5.1  User Guide



rpm -Uvh --relocate /var/avamar=var_path AvamarLotus-linux-
platform-version.rpm

where:

l var_path is the installation directory that you specified when you installed
the earlier version of the Avamar Plug-in for Lotus Domino software.

l platform-version is the platform type and Avamar version number.

The rpm -Uvh command automatically uninstalls the earlier version of the
Avamar Plug-in for Lotus Domino, and then installs the new version.

Uninstalling the Avamar Plug-in for Lotus Domino on RHEL
You can uninstall the Avamar Plug-in for Lotus Domino from an RHEL system by using
the rpm -e command.

When you uninstall the Avamar Plug-in for Lotus Domino and the Avamar Client for
Linux from the host system, scheduled backups no longer occur for the client. You
cannot restore backups to the client after you uninstall the software.

You can retire or delete a client either before or after you uninstall the Avamar Plug-in
for Lotus Domino:

l To keep the backups for the client so that you can restore the backups to a
different client, retire the client by using Avamar Administrator.

l To delete the backups for the client, delete the client by using Avamar
Administrator.

The Avamar Administration Guide provides more information.

Procedure

1. Log in to the Domino server as root.

2. To view the Avamar packages that are installed on the system, type the
following command:

rpm -qa | grep Av

Output similar to the following appears in the command shell:

AvamarLotus-version-nnn
AvamarClient-version-nnn

3. Uninstall the Avamar Plug-in for Lotus Domino by typing the following
command:

rpm -e AvamarLotus-version

where version is the version of the Avamar Plug-in for Lotus Domino.

4. Uninstall the Avamar Client for Linux by typing the following command:

rpm -e AvamarClient-version

where version is the version of the Avamar Client for Linux.

Installing, upgrading, and uninstalling on SLES
You can install, upgrade, and uninstall the Avamar Plug-in for Lotus Domino on SLES.
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Installing the Avamar Plug-in for Lotus Domino on SLES
You can install the Avamar Plug-in for Lotus Domino software in either the default
installation directory or an alternate directory. Install the Avamar Plug-in for Lotus
Domino in the same directory as the Avamar Client for Linux.

Procedure

1. Log in to the Domino server as root.

2. Change the directory to the temporary directory by typing the following
command:

cd /tmp

where tmp is the temporary install directory.

3. To install the Avamar Plug-in for Lotus Domino in the default directory, type the
following command:

rpm -ivh AvamarLotus-linux-platform-version.rpm

where platform-version is the platform type and Avamar version number.

Note

To change the base directory during the installation, skip this step and continue
to the next step.

4. To change the base directory during the installation, type the following
command:

rpm --relocate /usr/local/avamar=/new_path -i AvamarLotus-linux-
platform-version.rpm

where:

l new_path is the new directory.

l platform-version is the platform type and Avamar version number.

Note

To change the base directory and var directory locations during the
installation, skip this step and continue to the next step.

5. To change the base directory and var directory locations during the
installation, type the following command:

rpm -ivh --relocate /usr/local/avamar=new_base_path --
relocate /var/avamar=new_var_path AvamarLotus-linux-platform-
version.rpm

where:

l new_base_path is the new installation directory.

l new_var_path is the new var directory.

l platform-version is the platform type and Avamar version number.
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Upgrading the Avamar Plug-in for Lotus Domino on SLES
Upgrade the Avamar Plug-in for Lotus Domino to a later release by using the rpm -
Uvh command. Use the --relocate option to specify the alternate installation or
var directory that you specified when you installed the initial version. The Avamar
Client for Linux and Avamar Plug-in for Lotus Domino must be the same version.

Procedure

1. Upgrade the Avamar Client for Linux by using the instructions in the Avamar
Backup Clients User Guide.

2. Change the directory to the temporary directory by typing the following
command:

cd /tmp

3. To upgrade the software in the default directory, type the following command:

rpm -Uvh AvamarLotus-linux-platform-version.rpm

where platform-version is the platform type and Avamar version number.

Note

To upgrade the software in a nondefault installation directory, skip this step and
continue to the next step.

4. To upgrade the software in a nondefault installation directory, type the
following command:

rpm -Uvh --relocate /usr/local/avamar=new_base_path AvamarLotus-
linux-platform-version.rpm

where:

l new_base_path is the installation directory that you specified when you
installed the release 7.0.

l platform-version is the platform type and Avamar version number.

Note

To upgrade the software and use a nondefault var directory, skip this step and
continue to the next step.

5. To upgrade the software and use a nondefault var directory, type the following
command:

rpm -Uvh --relocate /var/avamar=new_var_path AvamarLotus-linux-
platform-version.rpm

where:

l new_var_path is the installation directory that you specified when you
installed release 7.0.

l platform-version is the platform type and Avamar version number.

The rpm -Uh command automatically uninstalls the earlier version of the
Avamar Plug-in for Lotus Domino, and then installs the new version.
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Uninstalling the Avamar Plug-in for Lotus Domino on SLES
When you uninstall the Avamar Plug-in for Lotus Domino and the Avamar Client for
Linux from the host system, scheduled backups no longer occur for the client. You
cannot restore backups to the client after you uninstall the software.

You can retire or delete a client either before or after you uninstall the Avamar Plug-in
for Lotus Domino:

l To keep the backups for the client so that you can restore the backups to a
different client, retire the client by using Avamar Administrator.

l To delete the backups for the client, delete the client by using Avamar
Administrator.

The Avamar Administration Guide provides more information.

Procedure

1. Log in to the Domino server as root.

2. To view the Avamar packages that are installed on the system, type the
following command:

rpm -qa | grep Avamar

Output similar to the following appears in the command shell:

AvamarLotus-version-nnn
AvamarClient-version-nnn

3. Uninstall the software by typing the following command:

rpm -e AvamarLotus-version AvamarClient-version

where version is the Avamar software version.

Installing, upgrading, and uninstalling on Solaris
You can install, upgrade, and uninstall the Avamar Plug-in for Lotus Domino on Solaris.

Installing the Avamar Plug-in for Lotus Domino on Solaris
Use the pkgadd command to install the Avamar Plug-in for Lotus Domino software.

Procedure

1. Log in to the Domino server as root.

2. Change the directory to the temporary directory by typing the following
command:

cd /tmp

where tmp is the temporary install directory.

3. Install the Avamar Plug-in for Lotus Domino by typing the following command:

pkgadd -d AvamarLotus-OS-sparc-version.pkg

where:

l OS is the Solaris operating system version. For example: solaris10.
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l version is the Avamar software version.

The following appears in the command shell:

The following packages are available:
1 AVMRlotus Avamar Client Plugin for IBM Lotus Domino
(sparc) 7.2.100-nnn\par

Select package(s) you wish to process (or 'all' to process
all packages). (default: all) [?,??,q]:

4. Type 1 and press Enter.

The following output appears in the command shell:

Processing package instance <AVMRlotus> from
</AvamarLotus-solaris10-sparc-7.2.100-nnn.pkg>

Avamar Client Plugin for IBM Lotus Domino(sparc) 7.2.100-
nnn
## Executing checkinstall script.
Using as the package base directory.
## Processing package information.
## Processing system information.
2 package pathnames are already properly installed.
## Verifying package dependencies.
## Verifying disk space requirements.
## Checking for conflicts with packages already installed.
## Checking for setuid/setgid programs.

This package contains scripts which will be executed with
super-user
permission during the process of installing this package.

Do you want to continue with the installation of
<AVMRlotus> [y,n,?]

5. Type y and press Enter.

The installation runs to completion.

Upgrading the Avamar Plug-in for Lotus Domino on Solaris

The versions of the Avamar Client for Solaris and Avamar Plug-in for Lotus Domino
must be the same.

Procedure

1. Uninstall the Avamar Plug-in for Lotus Domino. Uninstalling the Avamar Plug-in
for Lotus Domino on Solaris on page 38 provides instructions.

2. Uninstall the Avamar Client for Solaris. The Avamar Backup Clients User Guide
provides instructions.

3. Download the Avamar Client for Solaris and the Avamar Plug-in for Lotus
Domino installation packages. Downloading the software on page 27 provides
instructions.

4. Install the new version of the Avamar Client for Solaris. TheAvamar Backup
Clients User Guide provides instructions.
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5. Install the new version of the Avamar Plug-in for Lotus Domino. Installing the
Avamar Plug-in for Lotus Domino on Solaris on page 36 provides instructions.

Uninstalling the Avamar Plug-in for Lotus Domino on Solaris
When you uninstall the Avamar Plug-in for Lotus Domino and the Avamar Client for
Solaris from the host system, scheduled backups no longer occur for the client. You
cannot restore backups to the client after you uninstall the software.

You can retire or delete a client either before or after you uninstall the Avamar Plug-in
for Lotus Domino:

l To keep the backups for the client so that you can restore the backups to a
different client, retire the client by using Avamar Administrator.

l To delete the backups for the client, delete the client by using Avamar
Administrator.

The Avamar Administration Guide provides more information.

Procedure

1. Log in to the Domino server as root.

2. Display all Avamar packages that are installed on the system by typing the
following command:

pkginfo | grep AVMR

Information similar to the following appears in the command shell:

The following packages are currently installed:
1 AVMRlotus Avamar Client Plugin for IBM Lotus Domino
(sparc) 7.2.100-nnn

3. Uninstall the software by typing the following command:

pkgrm AVMRlotus

The following output appears in the command shell:

The following package is currently installed:
AVMRlotus
Do you want to remove this package?

4. Type y and press Enter.

The following output appears in the command shell:

Removal of AVMRlotus was successful.

Installing, upgrading, and uninstalling on Windows
You can install, upgrade, and uninstall the Avamar Plug-in for Lotus Domino on a
stand-alone Windows system or on a Windows cluster.

Installing the Avamar Plug-in for Lotus Domino on Windows
Install the Avamar Plug-in for Lotus Domino on both Windows stand-alone systems
and MSCS two-node clusters. In a cluster, install the Avamar Plug-in for Lotus Domino
on both nodes and in the same directory on each node.

If UAC is enabled on the client computer, you must start the setup wizard by using
administrator privileges. Otherwise, the software does not install correctly. This
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procedure provides one method to bypass UAC. The Microsoft documentation
provides other methods and additional information.

The Avamar Plug-in for Lotus Domino is automatically installed in the same folder as
the Avamar Client for Windows.

Procedure

1. Log in to the Domino server as an administrator.

2. Go to the temporary directory that contains the installation package that you
downloaded in Downloading the software on page 27.

3. Start the installation by using the correct method:

l If UAC is disabled, double-click the installation package.

l If UAC is enabled, right-click the Command Prompt icon and select Run as
administrator. Change to the directory that contains the installation
package and type the following command:

msiexec /i AvamarLotus-windows-platform-version.msi
where platform-version is the platform type and Avamar software version
number.

The welcome page appears.

4. Click Next.

The Ready to install Avamar Backup Plug-in for Lotus Domino page appears.

5. Click Install.

The Installing Avamar Backup Plug-in for Lotus Domino page appears. A
status bar shows the installation’s progress. After the installation completes,
the Completed the Avamar Backup Plug-in for Lotus Domino Setup Wizard
page appears.

6. Click Finish.

7. In a cluster, repeat this installation procedure on each node.

Configuring the cluster client on Windows
The Avamar cluster client enables you to back up and restore Domino data on shared
storage in a cluster, regardless of which node is managing the data at the time of the
backup or restore.

Before you begin

Before you run the Cluster Configuration Tool, ensure that the Avamar Client for
Windows and the Avamar Plug-in for Lotus Domino are installed on each node in the
cluster.

Use the Cluster Configuration Tool to configure the Avamar cluster client on the
active node in an active/passive configuration or on both active nodes in an active/
active configuration.

Procedure

1. Log in to the active node in the cluster as a domain administrator. The account
must be a member of the local Administrators group on each cluster node.

2. Start the Cluster Configuration Tool:

l On Windows Server 2012, open the Start screen and select Cluster
Configuration Tool.
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l On Windows Server 2008, open the Start menu and select Program Files  >
Avamar > Cluster Configuration Tool.

The welcome page appears.

3. Click Next.

The Plug-Ins page appears.

4. Select Lotus Domino from the Avamar Backup Plug-ins list, and then click
Next.

The Cluster Nodes page appears with a list of nodes and their status.

5. Ensure that the environment meets the following requirements:

l The status for each Lotus Domino node is Up.

l The installation status of the Windows client software for each node is
Installed.

l The installation status of the Avamar Plug-in for Lotus Domino software for
each node is Installed.

6. Click Next.

The Operations page appears.

7. Select Configure a new cluster client for all nodes, and then click Next.

Note

All cluster nodes must be registered to Avamar Server.

The Prerequisites page appears. A check mark next to a prerequisite indicates
that the prerequisite has been met.

8. Ensure that the environment meets all prerequisites on the Prerequisites page.

If a prerequisite is not met, exit the wizard, resolve the issue, and then restart
the wizard.

9. Select the Internet Protocol version that the environment uses, and then click
Next.

The Attach to Service page appears.

10. Select the cluster service to use for the cluster client, and then click Next.

The Server Settings page appears.

11. Specify the settings for the Avamar server:

a. Type either the DNS name of the Avamar server in the Name box or the IP
address in the IPv4/IPv6 address box.

The IP option that appears on this page depends on the choice you make in
step 9.

b. Type the name of the Avamar domain in the Avamar client domain for the
cluster client box.

To specify a domain at the root level, type /domain, where domain is the
domain name. To specify a subdomain, type /domain/subdomain, where
domain is the domain name and subdomain is the subdomain name.

c. Type the data port for Avamar client/server communication in the Port
number box.
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Port 28001 is the default port that the Avamar client uses to communicate
with the administrator server.

d. Click Next.

The Client settings page appears.

12. Specify the settings for the client:

a. Type the name of the shared network directory or volume where the Secure
Certificate is located in the Cluster client's SYSDIR directory box, or click
Browse to select the shared network directory or volume.

b. Type the name of the shared network directory or volume in the Cluster
client's var directory box, or click Browse to select a shared network
directory or volume.

The shared network directory or volume stores the cluster client
configuration and log files. All nodes in the cluster must have write access to
this directory or volume.

c. Click Next.

The Summary page appears.

13. Review the configuration settings, and then click Configure.

The Progress page provides the status of the configuration. When the
configuration process is complete, the Results page appears.

14. Click Close.

Upgrading the Avamar Plug-in for Lotus Domino on Windows
The steps to upgrade the Avamar Plug-in for Lotus Domino on Windows depend on
whether the installation is on a stand-alone server or in a cluster.

Upgrading on a stand-alone Windows server
When you upgrade the Avamar Plug-in for Lotus Domino on a stand-alone server, you
do not need to uninstall earlier versions before you install a new version. The
installation determines that an earlier version is installed, and then prompts you to
upgrade to the new version or remove the current version.

Procedure

1. Ensure that you meet all system requirements for the new version. Preparing to
install the Avamar Plug-in for Lotus Domino on page 26 provides information.

2. Upgrade the Avamar Client for Windows by running the Windows client
installation wizard for the new version on the client computer. The Avamar for
Windows Server User Guide provides instructions.

3. Upgrade the Avamar Plug-in for Lotus Domino by running the plug-in installation
wizard for the new version on the Windows server. Installing the Avamar Plug-in
for Lotus Domino on Windows on page 38 provides instructions.
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Upgrading in a Windows cluster
When you upgrade the Avamar Client for Windows and Avamar Plug-in for Lotus
Domino software in a cluster, you must uninstall earlier versions of the Avamar client
and plug-in from each node, and then install new versions.

Procedure

1. Uninstall the current version of the Avamar Client for Windows and Avamar
Plug-in for Lotus Domino:

a. To uninstall the Avamar cluster client, use the earlier version of the Cluster
Configuration Tool. Uninstalling in a cluster client on page 43 provides
instructions.

b. Uninstall the earlier version of the Avamar Plug-in for Lotus Domino on each
node in the cluster.

c. Uninstall the earlier version the Avamar Client for Windows on each node in
the cluster.

The plug-in guide for the earlier version provides instructions for each step.

2. Install the new version of the Avamar Client for Windows and Avamar Plug-in
for Lotus Domino:

a. Install the Avamar Client for Windows in the same directory on each node in
the cluster. The Avamar for Windows Server User Guide provides instructions.

b. Install the Avamar Plug-in for Lotus Domino in the same directory on each
node in the cluster. Installing the Avamar Plug-in for Lotus Domino on
Windows on page 38 provides instructions.

c. Register each node in the cluster with the Avamar server. The Avamar for
Windows Server User Guide provides instructions.

d. Use the Cluster Configuration Tool to install the Avamar Client for Windows
on an active node. Configuring the cluster client on Windows on page 39
provides instructions.

Uninstalling the Avamar Plug-in for Lotus Domino on Windows
When you uninstall the Avamar Plug-in for Lotus Domino and the Avamar Client for
Windows from the host system, scheduled backups no longer occur for the client. You
cannot restore backups to the client after you uninstall the software.

You can retire or delete a client either before or after you uninstall the Avamar Plug-in
for Lotus Domino:

l To keep the backups for the client so that you can restore the backups to a
different client, retire the client by using Avamar Administrator.

l To delete the backups for the client, delete the client by using Avamar
Administrator.

The Avamar Administration Guide provides more information.

The steps to uninstall the Avamar Plug-in for Lotus Domino on Windows depend on
whether the installation is on a stand-alone server or in a cluster.
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Uninstalling on a stand-alone Windows server
Use the Windows uninstall feature to uninstall the Avamar Client for Windows and
Avamar Plug-in for Lotus Domino software.

Procedure

1. Uninstall the Avamar Plug-in for Lotus Domino by using Programs and
Features.

2. Uninstall the Avamar Client for Windows by using Programs and Features.

Uninstalling in a cluster client
In a Windows cluster, use the Cluster Configuration Tool to uninstall the Avamar
cluster client. Then use the Windows uninstall feature to uninstall the Avamar Client
for Windows and Avamar Plug-in for Lotus Domino software from each node.

Procedure

1. Log in to the active node in the cluster as a domain administrator. The account
must also be a member of the local Administrators group on each cluster node.

2. Start the Cluster Configuration Tool:

l On Windows Server 2012, open the Start screen and select Cluster
Configuration Tool.

l On Windows Server 2008, open the Start menu and select Program Files  >
Avamar > Cluster Configuration Tool.

The welcome page appears.

3. Click Next.

The Plug-Ins page appears.

4. Select Lotus Domino from the Avamar Backup Plug-ins list, and then click
Next.

The Cluster Nodes page appears with a list of nodes and their status.

5. Ensure that the status of each node is Up, and then click Next.

The Operations page appears.

6. Select Remove the cluster client from all nodes, and then click Next.

The Prerequisites page appears. A check mark next to a prerequisite indicates
that the prerequisite has been met.

7. Click Next.

The Attach to Service page appears.

8. Select the cluster service that the cluster client uses, and then click Next.

The Summary page appears.

9. Review the configuration settings, and then click Uninstall.

The Progress page provides the status of the uninstall. When the uninstall is
complete, the Results page appears.

10. Click Close.
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Performing post-installation tasks
After a successful installation of the Avamar Plug-in for Lotus Domino completes,
perform the post-installation tasks that apply to the system type.

Moving flag files to the /var/clientlogs directory
The Avamar Plug-in for Lotus Domino, release 7.1 or later, uses the /var/
clientlogs directory for flag files, log files, and client cache files. The avtar
program from Avamar 7.1 or later creates all logs and cache files in /var/
clientlogs after you install or upgrade to 7.1 or later.

After you install or upgrade Avamar Plug-in for Lotus Domino, you must move flag
files, such as avtar.cmd or avlotus.cmd, from the /var directory to the /var/
clientlogs directory.

Before release 7.1, the Avamar Plug-in for Lotus Domino used the /var directory for
flag files, log files, and client cache file.
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CHAPTER 3

Backup

This chapter includes the following topics:

l Performing on-demand backups........................................................................ 46
l Scheduling backups........................................................................................... 49
l Restarting backups after cluster failover........................................................... 54
l Monitoring backups............................................................................................54
l Canceling backups............................................................................................. 55
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Performing on-demand backups
An on-demand backup is a user-initiated backup of specific data that you select.
Perform an on-demand backup for the first backup of the client immediately after you
install the Avamar client software. Also perform an on-demand backup before system
maintenance, installations, or software upgrades.

Before backing up an online database, the Avamar Plug-in for Lotus Domino sends a
request to the Domino server to flush pending I/O to the database file. This task
ensures that the backup process backs up the most current version of the database.

You can run an on-demand backup while the Domino server is running or stopped. The
Lotus Domino documentation provides more information on stopping and restarting a
Domino server.

Note

Do not back up an online database during a database compaction. A hot backup of a
database can fail during a database compaction.

Specifying the 32bitbinary flag on AIX systems
The 32bitbinary flag applies only to AIX systems with 32-bit and 64-bit Domino
server configurations. To back up data from the 32-bit version of Domino server on
AIX systems, you must specify the 32bitbinary flag. Specify the 32bitbinary
flag from Avamar Administrator or from the CLI.

Backing up Domino databases
Use Avamar Administrator to back up Domino database files.

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Backup tab.

The top-left pane contains a list of domains.

3. Click the domain that contains the Domino server.

A list of Avamar clients appears in the pane under the domains list.

4. Click the client that runs the Domino server.

The plug-ins installed on the Domino server appear in the left pane on the
Backup tab.

5. Select the Lotus Domino plug-in.

6. Click + next to the Lotus Domino plug-in to expand the subdirectories.

7. Select files to back up.

A backup selection automatically includes the notes.ini file. In the event of
catastrophic data loss, a disaster recovery requires the notes.ini file.

Backup

46 Avamar for Lotus Domino 7.5.1  User Guide



Figure 3 Backup selection

Disaster Recovery on page 75 provides more information.

8. Select Actions > Back Up Now.

The On Demand Backup Options dialog box appears.

9. Select a retention policy:

l To automatically delete this backup from the Avamar server after a specific
amount of time, select Retention period and specify the number of days,
weeks, months, or years for the retention period.

l To automatically delete this backup from the Avamar server on a specific
calendar date, select End date and browse to that date on the calendar.

l To keep this backup for as long as this client remains active in the Avamar
server, select No end date.

10. From the Avamar encryption method list, select an encryption method to use
for client/server data transfer during this backup.

The encryption technology and bit strength for a client/server connection
depend on several factors, including the client platform and Avamar server
version. The Avamar Product Security Guide provides more information.

11. Click More Options.

The Backup Command Line Options dialog box appears.

12. Set the plug-in options:
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a. Select Show Advanced Options to view advanced options.

b. Type a descriptive label for this backup in the Backup label field.

c. (Optional) Select Follow links to back up databases and directories pointed
to by Domino database and directory links.

d. Select the type of backup from the Backup type list:

l Select Full to back up all databases and files required for a complete
recovery.

l Select Incremental to back up transaction logs and new database files
that were created since the last full or incremental backup.

l Select Subset to back up the selected database and non-database files.

e. Type the full pathname of the notes.ini file on the Domino server in the
Full path of the Domino server’s notes.ini file field:

l On Windows, the default directory is C:\Program Files\IBM\Lotus
\Domino\notes.ini.

l On AIX, Linux, and UNIX, the default directory is /local/notesdata/
notes.ini.

f. Type the full pathname of the Domino directory in the Full path of the
Domino directory field.

g. (AIX, Linux, or UNIX) Type the Domino username in the Domino username
field.

This username is the OS user, who has permissions to start and stop the
Domino server on the operating systems. The default username is notes.

h. Select the number of backup streams to use from the Maximum number of
backup streams list. The default is 1. The maximum number of streams is 10.

i. Select a stream allocation option:

l Select Balance data among the streams based on total file size to
assign files to streams. Each stream receives an equal fraction of the
total file size.

l Select Balance data among the streams based on logical volume or
file system to assign individual streams to each volume.

j. Select or clear Transaction Logs options:

l Select Back up transaction logs with full backup to include transaction
logs with the backup. This option is selected by default.

l Select Archive transaction logs to archive transaction logs after the
backup. This option is selected by default.

l Select Terminate backup on error to terminate the backup if an error
occurs.

k. Select Store backup on Data Domain system, and then select the Data
Domain system from the list to store the backup on a Data Domain system
instead of the Avamar server.

l. From the Encryption method to Data Domain system list, select the
encryption method to use for data transfer between the client and the Data
Domain system during the backup.
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m. Click OK to close the Backup Command Line Options dialog box.

Backup options on page 98 provides more information about backup plug-in
options.

13. Click OK to close the On Demand Backup Options dialog box.

The following status message appears:

Backup initiated.
14. Click OK.

Backing up databases on DAOS-enabled servers

The Avamar Plug-in for Lotus Domino automatically backs up the DAOS directory for
all types of backups: full, incremental, and subset. You do not need to include the
DAOS directory in the backup request.

Procedure

1. Ensure that transaction logging is enabled. Setting ARCHIVE mode on the
Domino server on page 26 provides more information.

2. Complete all steps in Backing up Domino databases on page 46.

If you select the Archive transaction logs option in the Backup Command
Line Options dialog box, the Domino server archives the transaction logs after
the backup completes.

Scheduling backups
Scheduled backups run automatically to ensure that backups of the Domino data
occur on an ongoing basis. You can schedule backups to run daily, weekly, or monthly.
The scheduled backup can include multiple clients or a single server.

Procedure

1. Create a dataset for Domino server backups.

2. Create a group for backups.

During the group creation process, you:

a. Assign the new dataset to the new group.

b. Assign a schedule to the new group.

c. Assign a retention policy to the new group.

d. Add the Domino client to the new group.

The Avamar Administration Guide provides more information about groups, group
policy, datasets, schedules, and retention policies.

3. Enable scheduling for the group.
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Creating a dataset
A dataset specifies the data to include in a scheduled backup and the options to use
for the backup. Create at least one dataset for scheduled backups of Domino data on
a client or on a group of clients. Create multiple datasets to segregate client data.

Procedure

1. In Avamar Administrator, select Tools > Manage Dataset.

The Manage All Datasets window appears.

2. Click New.

The New Dataset dialog box appears.

3. In the Name field, type a name for the dataset.

The name can include alphanumeric characters (A-Z, a-z, 0-9) and the following
special characters: period (.), hyphen (-), and underscore (_). Do not use
Unicode characters or the following special characters: ` ~ ! @ # $ % ^ & * ( )
= + [ ] { } | \ / ; : ' " < > , ?

4. On the Source Data tab, select Enter Explicitly.

5. Select the Lotus Domino plug-in for the platform from the Select Plug-In Type
list.

6. Click ... (the Browse for files and/or folders button).

The Select Files and/or Folders dialog box appears.

7. In the Select Files and/or Folders dialog box:

a. Select the domain to view the clients.

A list of clients appears below the domain.

b. Select the client that runs the Domino server.

c. Select the Lotus Domino plug-in for the platform type.

The plug-ins installed on the Domino server appear in the left pane on the
Backup tab.

d. Click + next to the Lotus Domino plug-in to expand the subdirectories.

e. Select files to add to the dataset.

f. Click OK.

The Select Files and/or Folders dialog box closes and the New Dataset
dialog box lists the databases that you selected.

8. Remove all entries from the source list other than the Domino files that you
selected:

a. Select an entry from the list.

b. Click -.

c. Repeat steps a and b to remove all other entries.

The Source Data tab in the New Dataset dialog box should look similar to
the following figure.
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Figure 4 New Dataset window

9. Click the Options tab and set the plug-in options:

a. Select the Lotus Domino plug-in from the Select Plug-in Type list.

b. In the Backup label field, type a descriptive label for this backup.

c. (Optional) Select Follow links to back up databases and directories pointed
to by links.

d. From the Backup type list, select the type of backup:

l Full to back up all databases and files that are required for a complete
recovery.

l Incremental to back up transaction logs and new database files that
were created since the last full or incremental backup.

l Subset to back up the selected database files.

e. In the Full path of the Domino server’s notes.ini file field, type the full
pathname of the notes.ini file on the Domino server:

l On Windows, the default folder is C:\Program Files\IBM\Lotus
\Domino.

l On AIX, Linux, or UNIX, the default directory is /data/notesdata/.

f. In the Full path of the Domino directory, type the full pathname of the
Domino directory.
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g. (UNIX) In the Domino username field, type the Domino username.

This username is the OS user, who has permissions to start and stop the
Domino server on the UNIX operating systems. The default username is
notes.

h. Select the number of backup streams from the Maximum number of
streams list.

i. Select a stream allocation option:

l Select Balance data among the streams based on total file size to
assign files to streams. Each stream receives an equal fraction of the
total file size.

l Select Balance data among the streams based on logical volume or
file system to assign individual volumes or file systems to streams.

j. Select or clear Transaction Logs options:

l Select Back up transaction logs with full backup to include transaction
logs with the backup. This option is selected by default.

l Select Archive transaction logs to archive transaction logs after the
backup. This option is selected by default.

l Select Terminate backup on error to terminate the backup if an error
occurs.

k. Select Store backup on Data Domain system, and then select the Data
Domain system from the list to store the backup on a Data Domain system
instead of the Avamar server.

l. From the Encryption method to Data Domain system list, select the
encryption method to use for data transfer between the client and the Data
Domain system during the backup.

Plug-in Options on page 97 provides more information about specifying plug-
in options.

10. Click OK to close the New Dataset dialog box.

The new dataset is added to the list of datasets in the Manage All Datasets
dialog box.

11. Click OK to close the Manage All Datasets dialog box.

Creating a group
When you create a group, you define the dataset, schedule, and retention policy,
which together comprise the group policy for scheduled backups of all members of the
group. A group must contain at least one Avamar client. When the group contains two
or more clients, the clients must belong to the same Avamar domain. You can override
group policy settings at the client level.

Before you begin

You cannot edit schedules or retention policies when you use the New Group wizard
to create a group. Review existing schedules and retention policies. If required, create
new ones before you create the group. The Avamar Administration Guide provides
information about editing schedule properties or retention policies.
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Procedure

1. In Avamar Administrator, click the Policy launcher link.

The Policy window appears.

2. Select the Policy Management tab.

3. Select the Groups tab.

4. Click the domain for the Domino server.

The Policy window displays a table that contains groups for the domain.

5. Select Actions > Group > New > Backup Group.

The New Group wizard appears.

6. Type a name for the group in the Name field.

The name can include alphanumeric characters (A-Z, a-z, 0-9) and the following
special characters: period (.), hyphen (-), and underscore (_). Do not use
Unicode characters or the following special characters: ` ~ ! @ # $ % ^ & * ( )
= + [ ] { } | \ / ; : ' " < > , ?

7. Clear the Disabled checkbox to enable this group for scheduled client backups.

Selecting the checkbox disables backups for the group.

8. From the Avamar encryption method list, select an encryption method to use
for client/server data transfer during the backup.

The encryption technology and bit strength for the client/server connection
depend on several factors, including the client platform and Avamar server
version. The Avamar Product Security Guide provides more information.

9. (Optional) Select Override Schedule to override the assigned schedule for this
group:

l To skip the next scheduled backup, select Skip Next Backup.

l To perform the next scheduled backup one time only, select Run Next
Backup Once.

10. Click Next.

The next New Group page appears with dataset information.

11. Select the dataset you created from the Select an Existing Dataset list.

12. Click Next.

The next New Group page appears with schedule information.

13. Select a schedule from the Select An Existing Schedule list, and then click
Next.

The next New Group page appears with retention policy information.

14. Select a retention policy from the Select An Existing Retention Policy list, and
then click Next.

The final New Group page appears. A list of domains appear in the Choose
Domain pane.

15. Click the domain for the Domino server.

A list of Avamar clients appears in the pane under the Choose Domain pane.

16. Click the checkbox next to the clients to include in the group.

The clients appears in the Members pane.
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17. (Optional) To remove a client from the group, select the client from the
Members list, and then click the red X.

18. Click Finish.

The New Group wizard closes and the new group appears in the table in the
Policy window.

Enabling scheduled backups
Scheduled backups occur only for enabled groups. Groups are disabled by default
unless you select the Enabled checkbox on the first page of the New Group wizard. If
you did not enable the group when you created it, use the menu options in the Policy
window to enable backups.

Procedure

1. In Avamar Administrator, click the Policy launcher link.

The Policy window appears.

2. Click the Policy Management tab.

3. Click the Groups tab.

4. Click the domain for the Domino server.

5. Select the group that you created.

6. Enable the group by selecting Actions > Group > Disable Group.

Perform this step only if a check mark appears next to the Disable Group menu
option.

7. Click Yes to enable the group.

Restarting backups after cluster failover
Active backups fail during a cluster failover.

Procedure

l Manually restart failed backups on the new active node.

Monitoring backups
You can monitor backups to ensure that the backups complete successfully and to
troubleshoot issues. The Activity Monitor in Avamar Administrator enables you to
view status information for both on-demand and scheduled backups.

Procedure

1. In Avamar Administrator, click the Activity launcher link.

The Activity window appears.

2. Click the Activity Monitor tab.

A list of all activities appears.

3. To filter the results to display only backup activity, select Actions > Filter.

The Filter Activity dialog box appears.

4. Select All Backups from the Type list.
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5. Click OK.

Canceling backups
You can cancel a backup at any time before it completes. The cancellation can take
five minutes or more. The backup might complete before the cancellation finishes.

Procedure

1. In Avamar Administrator, click the Activity launcher link.

The Activity window appears.

2. Click the Activity Monitor tab.

A list of all activities appears.

3. Select the backup from the list.

4. Select Actions > Cancel Activity.

A confirmation message appears.

5. Click Yes.
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CHAPTER 4

Restore and Recovery

This chapter includes the following topics:

l DBIID or ReplicaID..............................................................................................58
l Specifying the 32bitbinary flag on AIX systems................................................. 58
l Restoring database files to the original directory............................................... 58
l Restoring database files to a different directory................................................ 62
l Restoring database files to a different client......................................................65
l Restoring databases on DAOS-enabled servers................................................. 70
l Restoring shared mail databases........................................................................ 72
l Restarting restores after cluster failover............................................................73
l Monitoring restores............................................................................................73
l Canceling restores............................................................................................. 73
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DBIID or ReplicaID
The Restore Command Line Options dialog box includes the two options that enable
you to change the DBIID or ReplicaID of a database: Create new DBIID during
recovery and Create new DBIID and ReplicaID during recovery.

You cannot specify the options to change the DBIID or ReplicaID of a database during
a recovery when transaction logging is not set to ARCHIVE mode for the database.

Specifying the 32bitbinary flag on AIX systems
The 32bitbinary flag applies only to AIX systems with 32-bit and 64-bit Domino
server configurations. To restore data from the 32-bit version of Domino server on AIX
systems, you must specify the 32bitbinary flag. You specify the 32bitbinary
flag from Avamar Administrator or from the CLI.

Restoring database files to the original directory
You can restore the Domino database and files to the original directory on the original
client by using Avamar Administrator.

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Restore tab.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

You cannot view clients outside the domain for the login account. To view all
clients, log in to the root domain.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Click the By Date tab.

6. Select the backup date from the calendar. Valid backups occurred on dates with
a yellow highlight.

A list of backups that were performed on that date appears in the Backups
table next to the calendar.

7. Select a backup from the Backups table.

The backup contents appear under the Contents of Backup pane.

8. Expand the folders in the Contents of Backup pane to display the database
files.

9. Select one or more folders from the Contents of Backup pane.

10. Select Actions > Restore Now.

The Restore Options dialog box appears.
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Figure 5 Restore Options dialog box

11. From the Avamar encryption method list, select an encryption method to use
for client/server data transfer during this restore.

The encryption technology and big strength for a client/server connection
depend on several factors, including the client platform and Avamar server
version. The Avamar Product Security Guide provides more information.

12. Select Restore everything to its original location.

13. Click More Options.

The Restore Command Line Options dialog box appears.

14. Set the plug-in options:

a. Select Bring all databases online after restore to bring all databases online
after the restore completes. This option is selected by default.

b. Select Overwrite database files to overwrite existing databases or files
with the restored data.

Selecting the Overwrite database files option takes the database offline
and deletes it before the restore operation.

c. (AIX, Linux, or UNIX) Type the Domino username in the Domino username
field.

This username is the OS user, who has permissions to start and stop the
Domino server on AIX, Linux, or UNIX systems. The default username is
notes.
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15. Select Show Advanced Options to display advanced restore options.

Restore options on page 99 provide more information about advanced restore
options.

a. Do not select the Enable debugging message option. This option is for
troubleshooting restore problems.

When the Enable debugging message option is selected, the Avamar Plug-
in for Lotus Domino creates large log files.

b. Select Restore system databases to restore system databases such as
busytime.nsf, ddm.nsf, events4.nsf, log.nsf, mail.box,
names.nsf, and mailjrn.nsf.

Note

You must stop the Domino server to restore system databases.

c. If the Lotus Domino configuration has changed or the Domino server has
been reinstalled in a new location, select Specify full paths for the Domino
configuration files and directory.

If you select Specify full paths for the Domino configuration files and
directory, type the full pathname for the notes.ini file in the Full path of
the Domino server’s notes.ini file field and the full pathname for the
Domino directory in the Full path of the Domino directory field.

d. If appropriate, select Pause replication of restored databases to
temporarily disable the replication of the successfully restored databases.
This option allows you to check or verify the status of the restored
databases before the databases are copied or synced to other replicas.

Note

After checking or verification, you should manually re-enable the replication
those databases via the Avamar Administrator GUI.

e. From the Encryption method from Data Domain system list, select the
encryption method to use for data transfer between the Data Domain
system and the client during the restore.

f. To use transaction logs to recover database files to a specific date and time,
leave Recover the database by using transaction logs selected. This
option is selected by default.

Clear Recover the database by using transaction logs if the database does
not use transaction logs.

g. To recover databases as a group, select Recover all databases as one
group per stream.

This option recovers all databases in groups rather than one at a time. If a
database encounters a problem during a group recovery, the recovery fails
for all databases in the group.

This option is for advanced users who are familiar with the recovery of
Domino databases.

h. To assign new DBIIDs to recovered databases, select Create new DBIID
during recovery.
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Because database transactions are specific to the DBIID, you cannot apply
transaction logs before the recovery. Avamar recognizes a database with a
new DBIID as a new database.

i. To have the Domino server assign new DBIIDs and ReplicaIDs to recovered
databases, select Create new DBIID and ReplicaID during recovery.

Because transactions are specific to the DBIID, you cannot apply transaction
logs before the recovery. Avamar recognizes a database with a new DBIID as
a new database.

j. Specify a Recover Time option:

l Select Now to restore each database to its original state at the time of
the backup. Then, transaction logs are used to recover all data until now.
Now is the default option.

l Select Other date/time to restore each database to its original state at
the time of the backup. Then, transaction logs are used to recover all
data up to the date and time you specify in the Recover date/time
(yyyy-mm-dd hh:mm:ss) field.

l Select Backup date/time to restore each database to its original state at
the time of its backup.

k. Specify a Recover Options option:

l Select Recover date/time (yyyy-mm-dd hh:mm:ss) to specify that
transaction logs should be used to recover all data up to the date and
time selected here.

l Select the number of transaction logs that should be pre-fetched in the
Transaction log pre-fetch value. This instructs the Lotus plug-in to
fetch more than one transaction log from backups at a time, which
improves recovery speed. The default is 5, and the maximum is 100.

l. (DAOS-enabled servers only) Select Restore missing NLO files to find and
restore missing NLO files that the database references.

The process of finding missing NLO files can take a long time.

m. (DAOS-enabled servers only) Select Synchronize DAOS catalog files to
synchronize the DAOS catalog file (DAOSCAT.NSF).

The resynchronization process can take a long time.

n. (DAOS-enabled servers only) Select Synchronize DAOS catalog files
normally to resynchronize DAOS catalog files by using the default method.

o. (DAOS-enabled servers only) Select Synchronize DAOS catalog files using
QUICK (Domino version 8.5.2 or later) to resynchronize DAOS catalog
files by using the QUICK option.

p. Click OK to close the Restore Command Line Options dialog box.

16. Click OK to close the Restore Options dialog box.

The following status message appears:

Restore initiated.
17. Click OK.
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Restoring database files to a different directory
You can restore Domino database files to a different target directory on the original
client by using Avamar Administrator.

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Restore tab.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

You cannot view clients outside the domain for the login account. To view all
clients, log in to the root domain.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Click the By Date tab.

6. Select the backup date from the calendar. Valid backups occurred on dates with
a yellow highlight.

A list of backups that were performed on that date appears in the Backups
table next to the calendar.

7. Select a backup from the Backups table.

The backup contents appear under the Contents of Backup pane.

8. Expand the folders in the Contents of Backup pane to display the database
files.

9. Select one or more folders from the Contents of Backup pane.

10. Select Actions > Restore Now.

The Restore Options dialog box appears.

11. Set options in the Restore Options dialog box:

a. From the Avamar encryption method list, select an encryption method to
use for client/server data transfer during this restore.

The encryption technology and big strength for a client/server connection
depend on several factors, including the client platform and Avamar server
version. The Avamar Product Security Guide provides more information.

b. Select Restore everything to a different location.

This option activates the Items Marked for Restore table and options.

c. Click Set Destination.

The Set Destination dialog box appears.

d. Click Browse.

The Browse for File, Folder, or Directory dialog box appears.

e. Select the target directory for the restore, and then click OK.

The Browse for File, Folder, or Directory dialog box closes. The directory
you selected appears in the Save Target(s) in Directory field.
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Figure 6 Set Destination dialog box

f. Click OK to close the Set Destination dialog box.

The Destination column in the Items Marked for Restore table contains
the target destination.

g. Click More Options.

The Restore Command Line Options dialog box appears.

12. Set the plug-in options:

a. Select Bring all databases online after restore to bring all databases online
after the restore completes. This option is selected by default.

b. Select Overwrite database files to overwrite existing databases or files
with the restored data.

c. (AIX, Linux, and UNIX only) Type the Domino username In the Domino
username field.

This username is the OS user, who has permissions to start and stop the
Domino server on AIX, Linux, or UNIX systems. The default username is
notes.

13. Select Show Advanced Options to display advanced restore options.

Restore options on page 99 provide more information about advanced restore
options.

a. Do not select the Enable debugging message option. This option is for
troubleshooting restore problems.

When the Enable debugging message option is selected, the Avamar Plug-
in for Lotus Domino creates large log files.

b. Select Restore system databases to restore system databases such as
busytime.nsf, ddm.nsf, events4.nsf, log.nsf, mail.box,
names.nsf, and mailjrn.nsf.
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Note

You must stop the Domino server to restore system databases.

c. If the Lotus Domino configuration has changed or the Domino server has
been reinstalled in a new location, select Specify full paths for the Domino
configuration files and directory.

If you select Specify full paths for the Domino configuration files and
directory, type the full pathname for the notes.ini file in the Full path of
the Domino server’s notes.ini file field and the full pathname for the
Domino directory in the Full path of the Domino directory field.

d. If appropriate, select Pause replication of restored databases to
temporarily disable the replication of the successfully restored databases.
This option allows you to check or verify the status of the restored
databases before the databases are copied or synced to other replicas.

Note

After checking or verification, you should manually re-enable the replication
those databases via the Avamar Administrator GUI.

e. From the Encryption method from Data Domain system list, select the
encryption method to use for data transfer between the Data Domain
system and the client during the restore.

f. To use transaction logs to recover database files to a specific date and time,
leave Recover the database by using transaction logs selected. This
option is selected by default.

Clear Recover the database by using transaction logs if the database does
not use transaction logs.

g. To recover databases as a group, select Recover all databases as one
group per stream.

This option recovers all databases in groups rather than one at a time. If a
database encounters a problem during a group recovery, the recovery fails
for all databases in the group.

This option is for advanced users who are familiar with the recovery of
Domino databases.

h. To assign new DBIIDs to recovered databases, select Create new DBIID
during recovery.

Because database transactions are specific to the DBIID, you cannot apply
transaction logs before the recovery. Avamar recognizes a database with a
new DBIID as a new database.

i. To have the Domino server assign new DBIIDs and ReplicaIDs to recovered
databases, select Create new DBIID and ReplicaID during recovery.

Because transactions are specific to the DBIID, you cannot apply transaction
logs before the recovery. Avamar recognizes a database with a new DBIID as
a new database.

j. Specify a Recover Time option:
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l Select Now to restore each database to its original state at the time of
the backup. Then, transaction logs are used to recover all data until now.
Now is the default option.

l Select Other date/time to restore each database to its original state at
the time of the backup. Then, transaction logs are used to recover all
data up to the date and time you specify in the Recover date/time
(yyyy-mm-dd hh:mm:ss) field.

l Select Backup date/time to restore each database to its original state at
the time of its backup.

k. Specify a Recover Options option:

l Select Recover date/time (yyyy-mm-dd hh:mm:ss) to specify that
transaction logs should be used to recover all data up to the date and
time selected here.

l Select the number of transaction logs that should be pre-fetched in the
Transaction log pre-fetch value. This instructs the Lotus plug-in to
fetch more than one transaction log from backups at a time, which
improves recovery speed. The default is 5, and the maximum is 100.

l. (DAOS-enabled servers only) Select Restore missing NLO files to find and
restore missing NLO files that the database references.

The process of finding missing NLO files can take a long time.

m. (DAOS-enabled servers only) Select Synchronize DAOS catalog files to
synchronize the DAOS catalog file (DAOSCAT.NSF).

The resynchronization process can take a long time.

n. (DAOS-enabled servers only) Select Synchronize DAOS catalog files
normally to resynchronize DAOS catalog files by using the default method.

o. (DAOS-enabled servers only) Select Synchronize DAOS catalog files using
QUICK (Domino version 8.5.2 or later) to resynchronize DAOS catalog
files by using the QUICK option.

p. Click OK to close the Restore Command Line Options dialog box.

14. Click OK to close the Restore Options dialog box.

The following status message appears:

Restore initiated.
15. Click OK.

Restoring database files to a different client
You can restore Domino database files to a different client by using Avamar
Administrator.

Before you begin

Ensure that the environment meets the following requirements before you restore
Domino database and files to a different client:

l The client must run the same type of operating system and the same or later
version of the Domino server as the original client.
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l The Domino server can have the same or different bitness as the original client.

l The operating system version of the new client can be different from the original
client. For example, you can restore a database from an AIX 6.1 client to an AIX 7.1
client as long as the Avamar Plug-in for Lotus Domino and Domino server support
the two versions of AIX.

The following limitations apply to restoring Domino database files to a different client:

l You cannot apply the transaction logs because the logs are not available on the
destination client.

An attempt to recover a logged database to a different client restores the
database, but fails to recover the database. In such a case, you cannot bring the
database online.

l You cannot restore a DAOS-enabled database to a different client because the
original clients' attachments are only accessible by the original client.

An attempt to restore a DAOS-enabled database to a different client successfully
restores the database. The restore does not enable access to the attachments
even if you specify the Restore missing NLO files option. In such a case, the
attachments stored in the NLO files are restored, but are not accessible because
the NLO files still reference the original client, not the new client.

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Restore tab.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

You cannot view clients outside the domain for the login account. To view all
clients, log in to the root domain.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Click the By Date tab.

6. Select the backup date from the calendar. Valid backups occurred on dates with
a yellow highlight.

A list of backups that were performed on that date appears in the Backups
table next to the calendar.

7. Select a backup from the Backups table.

The backup contents appear under the Contents of Backup pane.

8. Expand the folders in the Contents of Backup pane to display the database
files.

9. Select one or more folders from the Contents of Backup pane.

10. Select Actions > Restore Now.

The Restore Options dialog box appears.

11. Complete the settings in the Restore Options dialog box:

a. From the Avamar encryption method list, select an encryption method to
use for client/server data transfer during this restore.
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The encryption technology and big strength for a client/server connection
depend on several factors, including the client platform and Avamar server
version. The Avamar Product Security Guide provides more information.

b. Select Restore everything to a different location.

This option activates the Items Marked for Restore table and options.

c. Click Browse.

The Browse for Restore Destination Client dialog box appears.

Figure 7 Browse for Restore Destination Client dialog box

d. Click the Domino server client for the destination, and then click OK.

The destination Domino server client appears in the Restore Destination
Client field.

e. Click Set Destination.

The Set Destination dialog box appears.

f. Click Browse.

The Browse for File, Folder, or Directory dialog box appears.

g. Select the directory for the restore, and then click OK.

The Browse for File, Folder, or Directory dialog box closes. The directory
you selected appears in the Save Target(s) in Directory field.

h. Click OK to close the Set Destination dialog box.

The following figure shows the Restore Options dialog box after specifying
the options.
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Figure 8 Restore Options dialog box

i. Click More Options.

The Restore Command Line Options dialog box appears.

12. Set the plug-in options:

a. Select Bring all databases online after restore to bring all databases online
after the restore completes. This option is selected by default.

b. Select Overwrite database files to overwrite existing databases or files
with the restored data.

c. (AIX, Linux, or UNIX only) Type the Domino username In the Domino
username field.

This username is the OS user, who has permissions to start and stop the
Domino server on AIX, Linux, or UNIX systems. The default username is
notes.

13. Select Show Advanced Options to display all plug-in options.

a. Do not select the Enable debugging message option. This option is for
troubleshooting restore problems.

When the Enable debugging message option is selected, the Avamar Plug-
in for Lotus Domino creates large log files.

Restore and Recovery

68 Avamar for Lotus Domino 7.5.1  User Guide



b. Select Restore system databases to restore system databases such as
busytime.nsf, ddm.nsf, events4.nsf, log.nsf, mail.box,
names.nsf, and mailjrn.nsf.

Note

You must stop the Domino server to restore system databases.

c. Select Specify full paths for the Domino configuration files and
directory. Type the full pathname for the notes.ini file in the Full path
of the Domino server’s notes.ini file field and the full pathname for the
Domino directory in the Full path of the Domino directory field.

You must provide the correct paths to the Domino configuration files and the
notes.ini file on the destination client if they are different from the paths
on the original client.

d. If appropriate, select Pause replication of restored databases to
temporarily disable the replication of the successfully restored databases.
This option allows you to check or verify the status of the restored
databases before the databases are copied or synced to other replicas.

Note

After checking or verification, you should manually re-enable the replication
those databases via the Avamar Administrator GUI.

e. From the Encryption method from Data Domain system list, select the
encryption method to use for data transfer between the Data Domain
system and the client during the restore.

f. Clear all Recover options.

You cannot specify Recover options for a redirected restore operation.

g. Specify a Recover Time option.

l Select Now to restore each database to its original state at the time of
the backup. Then, transaction logs are used to recover all data until now.
Now is the default option.

l Select Other date/time to restore each database to its original state at
the time of the backup. Then, transaction logs are used to recover all
data up to the date and time you specify in the Recover date/time
(yyyy-mm-dd hh:mm:ss) field.

l Select Backup date/time to restore each database to its original state at
the time of its backup.

h. Clear Restore missing NLO files. You must not select this option for a
restore to a different client.

i. Select Synchronize DAOS catalog files to synchronize the DAOS catalog
(DAOSCAT.NSF).

j. (DAOS-enabled servers only) Select Synchronize DAOS catalog files
normally, to resynchronize DAOS catalog files by using the default method.

k. (DAOS-enabled servers only) Select Synchronize DAOS catalog files using
QUICK (Domino version 8.5.2 or later) to resynchronize DAOS catalog files
by using the QUICK option.
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l. Click OK to close the Restore Command Line Options dialog box.

14. Click OK to close the Restore Options dialog box.

The following status message appears:

Restore initiated.
15. Click OK.

Restoring databases on DAOS-enabled servers
You restore databases on DAOS-enabled servers by using Avamar Administrator. You
set specific options for DAOS-enabled servers in the Restore Command Line
Options dialog box.

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Restore tab.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

You cannot view clients outside the domain for the login account. To view all
clients, log in to the root domain.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Click the By Date tab.

6. Select the backup date from the calendar. Valid backups occurred on dates with
a yellow highlight.

A list of backups that were performed on that date appears in the Backups
table next to the calendar.

7. Select a backup from the Backups table.

The backup contents appear under the Contents of Backup pane.

8. Expand the folders in the Contents of Backup pane to display the database
files.

9. Select one or more folders from the Contents of Backup pane.

10. Select Actions > Restore Now.

The Restore Options dialog box appears.

11. From the Avamar encryption method list, select an encryption method to use
for client/server data transfer during this restore.

The encryption technology and big strength for a client/server connection
depend on several factors, including the client platform and Avamar server
version. The Avamar Product Security Guide provides more information.

12. Select Restore everything to its original location.

13. Click More Options.

The Restore Command Line Options dialog box appears.

14. In the Restore Command Line Options dialog box, select Show Advanced
Options to display all plug-in options.
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15. Do not select the Enable debugging messages option. This option is for
troubleshooting restore problems.

When the Enable debugging messages option is selected, the Avamar Plug-in
for Lotus Domino creates large log files.

16. Select Restore system databases to restore system databases such as
busytime.nsf, ddm.nsf, events4.nsf, log.nsf, mail.box,
names.nsf, and mailjrn.nsf.

You must stop the Domino server to restore system databases.

17. If the Lotus Domino configuration has changed or the Domino server has been
reinstalled in a new location, select Specify full paths for the Domino
configuration files and directory, and then complete the following steps:

a. Type the full pathname for the notes.ini file in the Full path of the
Domino server’s notes.ini file field.

b. Type the full pathname for the Domino directory in the Full path of the
Domino directory field.

18. If appropriate, select Pause replication of restored databases to temporarily
disable the replication of the successfully restored databases. This option allows
you to check or verify the status of the restored databases before the
databases are copied or synced to other replicas.

Note

After checking or verification, you should manually re-enable the replication
those databases via the Avamar Administrator GUI.

19. From the Encryption method from Data Domain system list, select the
encryption method to use for data transfer between the Data Domain system
and the client during the restore.

20. Specify Recover options:

a. To use transaction logs to recover database files to a specific date and time,
leave Recover the database by using transaction logs selected. This
option is selected by default.

b. To recover databases as a group, select Recover all databases as one
group per stream.

This option recovers all databases in groups rather than one at a time. If a
database encounters a problem during a group recovery, the recovery fails
for all databases in the group.

This option is intended for advanced users who are familiar with the
recovery of Domino databases.

c. To assign new DBIIDs to recovered databases, select Create new DBIID
during recovery.

Because database transactions are specific to the DBIID, you cannot apply
transaction logs before the recovery. Avamar recognizes a database with a
new DBIID as an entirely new database.

d. To have the Domino server assign new DBIIDs and ReplicaIDs to recovered
databases, select Create new DBIID and ReplicaID during recovery.
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Because transactions are specific to the DBIID, you cannot apply transaction
logs before the recovery. Avamar recognizes a database with a new DBIID as
an entirely new database.

21. Specify a Recover Time option:

l Select Now to restore each database to its original state at the time of the
backup. Then, transaction logs are used to recover all data until now. Now is
the default option.

l Select Other date/time to restore each database to its original state at the
time of the backup. Then, transaction logs are used to recover all data up to
the date and time you specify in the Recover date/time (yyyy-mm-dd
hh:mm:ss) field.

l Select Backup date/time to restore each database to its original state at
the time of its backup.

22. Specify DAOS Options:

a. Select Restore missing NLO files to restore missing NLO files.

b. Select Synchronize DAOS catalog files to synchronize the DAOS catalog
(DAOSCAT.NSF).

23. Specify DAOS Catalog Resync Options:

l Select Synchronize DAOS catalog files normally to resynchronize DAOS
catalog files by using the default method.

l Select Synchronize DAOS catalog files using QUICK (Domino version
8.5.2 or later) to resynchronize DAOS catalog files by using the QUICK
option.

24. Click OK to close the Restore Command Line Options dialog box.

25. Click OK to close the Restore Options dialog box.

The following status message appears:

Restore initiated.
26. Click OK.

Restoring shared mail databases
Before you restore shared mail databases, you must take the Domino server offline
and delete the shared mail database.

You cannot take a shared mail database offline. An on-demand restore of a shared mail
database file fails and returns a message similar to the following:

5098 -> The database is in use and cannot be taken off-line
You must first delete the shared mail database, and then restore it.

Procedure

1. Log in to the Domino server as a Domino administrator.

2. Take the Domino server offline.

3. Use Avamar Administrator to restore the shared mail database:

a. Restore the shared mail database to a directory other than the original
directory. Restoring database files to a different directory on page 62
provides instructions.
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Copy the restored shared mail database to the original location.

4. After the restore completes, bring the Domino server back online.

Restarting restores after cluster failover
Active restores fail during a cluster failover.

Procedure

l Manually restart failed restores on the new active node.

Monitoring restores
You can monitor restores to ensure that the restores complete successfully and to
troubleshoot issues. The Activity Monitor in Avamar Administrator enables you to
view status information for restores.

Procedure

1. In Avamar Administrator, click the Activity launcher link.

The Activity window appears.

2. Click the Activity Monitor tab.

A list of all activities appears.

3. To filter the results to display only restore activity, select Actions > Filter.

The Filter Activity dialog box appears.

4. Select Restore from the Type list.

5. Click OK.

Canceling restores
You can cancel a restore any time before it completes. The cancellation can take five
minutes or more. The restore might complete before the cancellation finishes.

Procedure

1. In Avamar Administrator, click the Activity launcher link.

The Activity window appears.

2. Click the Activity Monitor tab.

A list of all activities appears.

3. Select the restore from the list.

4. Select Actions > Cancel Activity.

A confirmation message appears.

5. Click Yes.
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CHAPTER 5

Disaster Recovery

This chapter includes the following topics:

l Preparing for disaster recovery..........................................................................76
l Performing a disaster recovery.......................................................................... 76
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Preparing for disaster recovery
Loss of data can result from accidental loss of active Logger files, a disk failure, or a
server crash. For protection against disaster, ensure that you take regular backups
that include database file as well as other key files, such as the notes.ini file.

Disaster recovery of the Domino server requires the following files:

l The notes.ini file from the Domino server.

l Backups for the lost databases.

l For DAOS-enabled servers, backups of all DAOS files associated with the
databases.

Note

Attachments are not recovered if any .NLO files are missing in the backup.

l Archived log extents (if transaction logging is enabled).

Note

The disaster recovery process changes the DBIID. Perform a full backup of the
Domino server and its databases after the disaster recovery procedure. A full backup
ensures that the databases are correctly associated with specific entries in the
transaction log.

Performing a disaster recovery

Procedure

1. Replace the hardware and install the software. Installing Avamar and Domino
software on page 76 provides instructions.

2. Restore the notes.ini file. Restoring the notes.ini file on page 77 provides
instructions.

3. Configure the notes.ini file. Configuring the notes.ini file on page 80
provides instructions.

4. Restore the last transaction log file. Restoring the last transaction log file on
page 80 provides instructions.

5. Restore and recover the data. Restoring and recovering data to the new
Avamar client on page 82 provides instructions.

6. Copy the files that you restore to the appropriate directory. Copying restored
files to the appropriate directory on page 84 provides instructions.

7. Perform a full backup of the Domino server and databases. Performing a full
backup of the Domino server and databases on page 85 provides instructions.

Installing Avamar and Domino software

Procedure

1. Replace hardware, if required

2. Install the Avamar file system client and the Avamar Plug-in for Lotus Domino. 
Chapter 2, “Installation and Configuration,” provides instructions.
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3. Register and activate the client with the Avamar server.

The Avamar Administration Guide provides instructions for registering and
activating clients.

4. Stop all Domino server-related services.

5. Delete the Domino installation directory and data directories.

6. Reboot the operating system on the Domino server host.

7. Reinstall the Domino server software with the same directory structure as the
previous installation.

Restoring the notes.ini file
To restore the notes.ini file, you must create a user for the Avamar client, retrieve
the label number for the backup, and retrieve the pathname to the notes.ini file.

Creating a user for the Avamar client

Procedure

1. In Avamar Administrator, click the Administration launcher link.

The Administration window appears.

2. Click Account Management.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Select Actions > Account Management > New User(s).

The New User(s) dialog box appears.

6. Select an authentication system from the Authentication System list.

7. Select Everyone to designate roles for all users on this client.

Note

Internal Avamar authentication systems do not use this field.

8. Select User Name and type the new username.

If you are using an external authentication system, this must be the username
you use to log in to that system. Usernames cannot be longer than 31
characters.

9. Select a role for this user from the Role list.

10. Type the password in the Password field.

For the internal authentication system, Avamar passwords are case-sensitive
and must adhere to the following requirements:

l Contain 6–12 characters

l Contain only alphanumeric, hyphen, period, or underscore characters

l Contain at least one alphanumeric character
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Note

External authentication systems do not use this field.

11. In the Confirm field, retype the password to confirm that you typed it correctly
in the Password field.

Note

External authentication systems do not use this field.

12. Click OK.

A confirmation dialog box appears.

13. Click OK to close the confirmation message dialog box.

The new user appears in the client’s list of users.

Retrieving the label number for the backup

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Restore tab.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

You cannot view clients outside the domain for the login account. To view all
clients, log in to the root domain.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Click the By Date tab.

6. Select a backup from the calendar.

Details for the backup appear in the table to the right of the calendar.
The numbers in the Number column represent label numbers. The avtar.exe
(Windows) or avtar (AIX, Linux, or UNIX) commands use these numbers.

Retrieving the pathname to the notes.ini file
To retrieve the pathname to the notes.ini file, use avtar.exe for Windows systems
or avtar for AIX, Linux, or UNIX systems.

Procedure

1. Open a Command Prompt window on Windows or a command shell on AIX,
Linux, or UNIX.

2. Change to the installation directory:

l On Windows, the default installation directory is C:\Program Files\avs
\bin.

l On AIX or Linux, the default installation directory is /usr/local/avamar/
bin.
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l On Solaris, the default installation directory is /opt/AVMRclnt/bin.

3. Change the user to Domino user account.

4. Type the following command specific to the platform:

l On Windows, type the following command:

avtar.exe --list --id=user@auth/clients/client-name --
password=password --labelnum=num

l On AIX, Linux, or UNIX, type the following command:

avtar --list --id=user@auth/clients/client–name --
password=password --labelnum=num

where:

l user is the Avamar username.

l auth is the authentication system.

The internal authentication system for the Avamar server is “avamar.” For
example: --id=user@avamar/clients/client-name.

l client-name is the full name of the client.

l password is the password for the --id=user@auth account.

l num is the label number from Retrieving the label number for the backup on
page 78.

The output from the avtar.exe or avtar command contains the pathname to
the notes.ini file. The following output from a Windows platform shows the
notes.ini file in the C:\Program Files\IBM\Lotus\Domino folder:

...
C:\Program Files\IBM\Lotus\Domino\data\webadmin.ntf
C:\Program Files\IBM\Lotus\Domino\data\wpdic.dic
C:\Program Files\IBM\Lotus\Domino\notes.ini

5. From the Avamar backup server, restore the notes.ini file to a temporary
directory:

l On Windows, type the following command:

avtar.exe -x path\notes.ini" --id=user@auth/clients/client-
name --password=password --target=C:\tmp --labelnum=num

l On AIX, Linux, or UNIX type the following command:

avtar -x path/notes.ini" --id=user@auth/clients/client-name --
password=password --target=/tmp --labelnum=num

where:

l path is the full pathname to the notes.ini file.

l user is the Avamar username.

l auth is the authentication system.

The internal authentication system for the Avamar server is “avamar.” For
example: --id=user@avamar/clients/client-name.

l client-name is the full name of the client.

l password is the password for the --id=user@auth account.

l num is the label number from Retrieving the label number for the backup on
page 78.
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Note

Do not use the Avamar Plug-in for Lotus Domino to restore the notes.ini file.

Configuring the notes.ini file

Procedure

1. Replace the notes.ini file with the restored notes.ini file.

2. (Optional) To recover the Domino server and databases to an AIX, Linux, or
UNIX system, change the ownership of the restored notes.ini file to the
Domino user account.

Note

The default account is notes. The Domino server uses this user account for
tasks such as starting and stopping the Domino server.

3. Edit the notes.ini file to set the following parameter:

TRANSLOG_Recreate_Logctrl=1

4. Save the notes.ini file.

Restoring the last transaction log file

Procedure

1. To list all files in the backup, use the avtar.exe command for a Windows
platform or the avtar command for an AIX, Linux, or UNIX system:

l On Windows, type the following command:

avtar.exe --list --internal --id=user@auth/clients/client-name
--password=password --labelnum=num

l On AIX, Linux, or UNIX, type the following command:

avtar --list --internal --id=user@auth/clients/client-name --
password=password --labelnum=num
where:

n user is the Avamar username.

n auth is the authentication system.

The internal authentication system for the Avamar server is “avamar.”
For example: --id=user@avamar/clients/client-name

n client-name is the full name of the client.

n password is the password for the --id=user@auth account.

n num is the label number from Retrieving the label number for the backup
on page 78.

The avatar.exe or avtar command displays screen output similar to the
following:

...
$MetaTxnLogdrive$:
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\7ce091d8c289e5850022528e65257583S0000049.TXN
$MetaTxnLogdrive$:
\7ce091d8c289e5850022528e65257583S0000050.TXN
$MetaTxnLogdrive$:
\7ce091d8c289e5850022528e65257583S0000051.TXN
$MetaTxnLogdrive$:\avlotus_metainfo.metafile
...

2. Determine the last transaction log file from the screen output in step 1.

In the sample screen output, the last transaction log file is:

/\$MetaTxnLogdrive\$:/
7ce091d8c289e5850022528e65257583S0000051.TXN

The last transaction log file has the largest sequence number (...S0000051,
for example).

Note

In rare cases when the restore process depletes sequence numbers, sequence
numbering restarts at 1. In this case, find a gap in the sequence and use the
largest sequence number after the gap.

3. To restore the transaction log file to a different folder, use the avtar.exe
command for a Windows platform or the avtar command for an AIX, Linux, or
UNIX system:

l On Windows, type the following command:

avtar.exe -x "$MetaTxnLogdrive$:
\7ce091d8c289e5850022528e65257583S0000051.TXN" --id=user@auth/
clients/client-name --password=password --target=c:\tmp --
labelnum=num --internal

l On AIX, Linux, or UNIX, type the following command:

avtar -x "/\$MetaTxnLogdrive\$:/
7ce091d8c289e5850022528e65257583S0000051.TXN" --id=user@auth/
clients/client-name --password=password --target=c:\tmp --
labelnum=num --internal

where:

l user is the Avamar username.

l auth is the authentication system.

The internal authentication system for the Avamar server is “avamar.” For
example: --id=user@avamar/clients/client-name.

l path is the full pathname to the TXN file.

Replace the sequence number that follows path with the sequence number
from the transaction log file.

l client-name is the full name of the client.

l password is the password for the --id=user@auth account.

l num is the label number from Retrieving the label number for the backup on
page 78.
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4. Rename the transaction log files to their original names.

Note

The Avamar Plug-in for Lotus Domino changes the names of the transaction log
files when they are backed up. The original names comprise the last 12
characters of the backup name. In the example in this procedure, the original
name of the transaction log file is S0000051.TXN.

5. Create a folder for the restored transaction log files. Use the original pathname
and folder name.

Use the Translog_Path variable in the notes.ini file to determine the
original pathname and folder name.

6. Copy the restored transaction log files to the folder you created in step 5.

7. If you use shared mail, restore shared mail databases. Restoring shared mail
databases on page 72 provides instructions.

8. (Optional) Change the ownership of the transaction log files to the Domino user
account.

The Domino server uses this user account (by default, notes) for tasks such as
starting and stopping the Domino server.

Restoring and recovering data to the new Avamar client

Procedure

1. In Avamar Administrator, click the Backup & Restore launcher link.

The Backup, Restore and Manage window appears.

2. Click the Restore tab.

The top-left pane contains a list of domains.

3. Select the domain that contains the Domino server.

You cannot view clients outside the domain for the login account. To view all
clients, log in to the root domain.

A list of Avamar clients appears in the pane under the domains list.

4. Select the client that runs the Domino server.

5. Click the By Date tab.

6. Select the backup date from the calendar. Valid backups occurred on dates with
a yellow highlight.

A list of backups that were performed on that date appears in the Backups
table next to the calendar.

7. Select a backup from the Backups table.

The backup contents appear under the Contents of Backup pane.

8. Expand the folders in the Contents of Backup pane to display the database
files.

9. Select one or more folders from the Contents of Backup pane.

10. Select Actions > Restore Now.

The Restore Options dialog box appears.

Disaster Recovery

82 Avamar for Lotus Domino 7.5.1  User Guide



11. Set options in the Restore Options dialog box:

a. From the Avamar encryption method list, select an encryption method to
use for client/server data transfer during this restore.

The encryption technology and big strength for the client and server
connection depend on several factors, including the client platform and
Avamar server version. The Avamar Product Security Guide provides more
information.

b. Select Restore everything to a different location.

This option activates the Items Marked for Restore table and options.

Note

Do not restore database files to a client other than the original client.

c. Click Set Destination.

The Set Destination dialog box appears.

d. Click Browse.

The Browse for File, Folder, or Directory dialog box appears.

e. Select the target destination for the restore, and then click OK.

The target appears in the Destination field.

f. Click OK to close the Set Destination dialog box.

In the Restore Options dialog box, the Destination column in the Items
Marked for Restore table contains the target destination.

g. Click More Options.

The Restore Command Line Options dialog box appears.

12. Set the plug-in options:

a. Select Show Advanced Options to display all plug-in options.

b. Select Overwrite database files.

c. (AIX, Linux, or UNIX) Type the Domino username in the Domino username
field.

This username is the OS user, who has permissions to start and stop the
Domino server on AIX, Linux, or UNIX systems. The default username is
notes.

d. Do not select the Enable debugging messages option. This option is for
troubleshooting restore problems.

When the Enable debugging messages option is selected, the Avamar
Plug-in for Lotus Domino creates large log files.

e. Select Restore system databases.

f. Select Specify full paths for the Domino configuration files and directory
if you changed the Lotus Domino configuration or if you reinstalled the
Domino server in a new location. Then type the full pathname for the
notes.ini file in the Full path of the Domino server’s notes.ini file field
and the full pathname for the Domino directory in the Full path of the
Domino directory field.

Disaster Recovery

Restoring and recovering data to the new Avamar client      83



g. If appropriate, select Pause replication of restored databases to
temporarily disable the replication of the successfully restored databases.
This option allows you to check or verify the status of the restored
databases before the databases are copied or synced to other replicas.

Note

After checking or verification, you should manually re-enable the replication
those databases via the Avamar Administrator GUI.

h. Specify Recover options. The Restore options on page 99 provide more
information about the Recover options.

i. Specify a Recover Time option. The Restore options on page 99 provide
more information about the Recover Time options.

j. Select Restore missing NLO files to find and restore missing NLO files that
the database references.

Note

The process of finding missing NLO files can take a long time.

k. Select Synchronize DAOS catalog files to synchronize the DAOS catalog
file (DAOSCAT.NSF).

Note

The resynchronization process can take a long time.

l. Select Synchronize DAOS catalog files normally to resynchronize DAOS
catalog files by using the default method.

m. Select Synchronize DAOS catalog files using QUICK (Above Domino
version 8.5.2) to resynchronize DAOS catalog files by using the QUICK
option.

n. Click OK to close the Restore Command Line Options dialog box.

13. Click OK to close the Restore Options dialog box.

The following status message appears:

Restore initiated.
14. Click OK.

Copying restored files to the appropriate directory

Procedure

1. Copy the restored files to the same directory structure as the original directory
structure.

For example, if the directory, D:\restoredfiles\c\Program Files\IBM
\Lotus\domino\data, contains the restored files and the original directory
structure is C:\Program Files\IBM\Lotus\domino\data, copy D:
\restoredfiles\c\Program Files\IBM\Lotus\domino\data to C:
\Program Files\IBM\Lotus\domino\data.
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Overwrite the files in the destination directory.

2. (Domino DAOS-enabled servers only) Restore the DAOS directory:

a. Create a folder for the restored DAOS (.NLO) files.

To determine the original pathname and directory, see the DAOSBasePath
variable in the notes.ini file. If the DAOS directory was created in the
data directory, the pathname is relative to the data directory.

b. Restore only the .NLO files from the backup to the DAOS directory.

3. Start the Domino server.

Lotus Domino documentation provides more information about stopping and
restarting a Domino server.

Performing a full backup of the Domino server and databases
After completing a successful disaster recovery, perform a full backup of the Domino
server and databases to ensure that the DBIIDs of the databases are in sync with the
transaction log file entries.

Procedure

l Complete the steps in Backing up Domino databases on page 46.
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CHAPTER 6

Backup Performance Optimization

This chapter includes the following topics:

l Use of separate disks in the Domino environment.............................................. 88
l RAID levels appropriate for content................................................................... 88
l Analyzing the Domino server disk or partition.................................................... 89
l Compacting Domino databases..........................................................................90
l Update indexes.................................................................................................. 90
l Clustered server replication............................................................................... 90
l Minimizing log activity........................................................................................ 91
l Use of multiple streams for backups...................................................................91
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Use of separate disks in the Domino environment
Use separate RAID arrays with their own controllers for the operating system, the
data, DAOS directory, and the transaction logs.

To operate at peak performance, the Domino server requires fast access to its
components, especially the databases, and transaction logs. The following table
provides an example configuration.

Table 5 RAID configuration

RAID configuration Contents

C: O/S Installation C:\WINNT

D: Lotus Domino Server binary installation D:\Lotus\Domino

E: Lotus Domino application data installation E:\Lotus\Domino\Data

F: Transaction log directory F:\TransLog

Using a separate RAID array device and controller for Domino data:

l Maximizes throughput to the databases.

l Reduces disk contention when Avamar is reading the Domino databases for
backup.

RAID levels appropriate for content
You can assign different RAID levels to best meet the storage requirements. For
example, use a RAID 1 (mirroring) device for the transaction logs. RAID 1 arrays
provide data protection, fast restores, and fast writes. A RAID 1 array device enables
fast access to the transaction logs, which enables a fast and accurate recovery of files
and data.

RAID 01 (striping and mirroring)
System administrators commonly use RAID 01 (striping and mirroring) for the
operating system, the Domino program files, and the transaction logs. You can also
use RAID 01 for data.

The advantages of RAID 01 are its speed and its maximum redundancy. The
disadvantage of RAID 01 is its mirroring capability doubles the storage capacity
requirements.

Storage capacity requirements are not an issue for the operating system and the
program files in comparison to the transaction logs. The operating system and
program files do not change or require more space.

RAID 1 (striping) or unprotected disks
Some Domino installations use striping or unprotected disks for the operating system
and program files. In case of a disk failure, you can restore the operating system and
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program files from a backup. The disadvantages of RAID1 are its inability to restore a
mirror image or automatically rebuild the drive.

RAID 5
Both RAID 5 and RAID 01 are used for data. RAID 5 is the most common RAID level for
storing data. The advantage of RAID 5 is that its storage capacity requirements are
less than those of RAID 01. The disadvantage of RAID 5 is that it is not as fast as RAID
01. Each RAID 5 write requires three additional writes per operation.

Analyzing the Domino server disk or partition
Domino writes files and deletes files to and from the disk. Over time, this ongoing
process of writing and deleting files causes disk fragmentation. Eventually, files that
are written to the disk are no longer stored contiguously, but as multiple parts or
extents.

Once a drive becomes fragmented, access to Domino database files becomes slower
because of increased disk head movement. Disk speed and disk contention can also
degrade backup performance. To ensure the best possible backup performance by
Avamar, perform regular disk analysis to determine the level of fragmentation. To
analyze the disk for fragmentation, use the Microsoft Disk Defragmenter tool.

Note

The Lotus Notes and Domino wiki website provide more information about disk
fragmentation specific to Lotus Domino Server. Search for “disk fragmentation.”

Procedure

1. Log in to the Domino server.

2. From the Start menu, select All Programs > Accessories > System Tools >
Disk Defragmenter.

The Disk Defragmenter dialog box appears.

3. Select the partition or disk that contains the Domino database files and click
Analyze disk.

When the disk analysis finishes, a status dialog box appears.

4. Click View Report.

The Analysis Report appears.

5. Review the report:

l Monitor the hard disk performance if the report contains files with more
than 600 fragments.

l Run maintenance on the partition or disk if the report contains files with
2,000 or more fragments.

6. Defragment the disk if the report recommends disk defragmentation.

Results

The speed of disk reads increase after you defragment the disk, which improves
backup performance.
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Compacting Domino databases
The Domino Compact task compacts each database to free unused space.
Compacting a database reduces or reuses database space. The backup window for
database backups is shorter after you compact the database.

The following table lists compacting options for the Domino server.

Table 6 Domino server compacting options

Type Command-line option

In-place compacting with space recovery
(recommended)

-b

In-place compacting with space recovery and
reduction in file size

-B

Copy-style -c

Copy-style: Allow access while compacting -L

Copy-style: Ignore errors and proceed -i

The copy-style compaction (-c) option creates a database with a new DBIID. Run a
full backup on this database. If you run an incremental backup after you use copy-style
compaction on a database, the backup will be a full backup. Avamar requires a full
backup before you can run an incremental backup.

The Lotus Domino documentation provides more information about compacting
Domino databases.

To help maintain optimal backup performance perform the following tasks:

Procedure

1. Regularly compact the database by running In-place compacting with space
recovery only (-b option).

2. Defragment the disk after compacting the database.

3. Ensure that the compaction schedule and the backup schedule do not overlap.

Update indexes
The Domino Update task updates and rebuilds the database views indexes and the full-
text indexes. The Update task runs in the background and is intended to improve
database response time when a user opens a database view.

Unnecessary activity from the Update task can impact the Domino server’s response
time and overall performance. Ensure that the Update schedule and the backup
schedule do not overlap.

The Lotus Domino documentation provides more information about the Domino
Update task.

Clustered server replication
Use a separate network port for cluster replication on clustered servers. The extensive
use of Domino replication is one of Domino’s most powerful features. Replication can
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negatively affect backup performance by overloading a clustered server’s
communication channels.

The Lotus Domino documentation provides more information about the Domino
replication.

Minimizing log activity
Domino logging activities can impact performance. Take the appropriate actions to
minimize logging activity on the Domino server.

Procedure

1. Limit the amount of information that is logged to the log.nsf file and the
console log.

2. Set the lowest level of verbosity for mail logging, log_replication,
log_update, and so forth.

The Server document stores logging options.

Note

Reducing the amount of log output can lower CPU usage.

3. Disable Log files and DOMLOG.NSF in the Enable logging section on the HTTP
server.

Web performance improves when you disable HTTP server logging.

4. After troubleshooting a problem, disable all parameters that start with “debug.”

Debug parameters can add CPU overhead and generate a large amount of log
output.

Use of multiple streams for backups
To improve backup performance, you can specify multiple backup streams.

The Avamar Plug-in for Lotus Domino provides two methods for performing backups
that use multiple streams. The following table describes these two methods.

Table 7 Multiple streams methods

Method Description

Non-volume based The equivalent option in the Backup
Command Line Options dialog box is

Balance data among the streams based
on total file size option.

Volume based The equivalent option in the Backup
Command Line Options dialog box is

Balance data among the streams based
logical volume of file system option.
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Non-volume based backups
The Avamar Plug-in for Lotus Domino uses two methods for backing up data with the
non-volume based approach: sized-based backups and queue-based backups.

The Avamar Plug-in for Lotus Domino performs size-based and queue-based backups
when you specify an Avamar server as the target storage device. For backups that use
a Data Domain system as the target storage device, the Avamar Plug-in for Lotus
Domino uses a single queue.

Size-based backups
For size-based backups, the Avamar Plug-in for Lotus Domino divides data into
streams that are based on the size of the data.

The following figure shows the process flow for size-based backup streams.

Figure 9 Size-based backup streams

The backup process flow for size-based backup streams proceeds as follows:

1. The Avamar Plug-in for Lotus Domino determines the size of the data.

2. The Avamar Plug-in for Lotus Domino evenly divides the data into the number of
streams you specify. For example in Figure 9 on page 92, the Avamar Plug-in for
Lotus Domino divides 1000 GB of data into four 250 GB backup streams.

3. The Avamar Plug-in for Lotus Domino starts the first backup stream when the
backup adds the first file to the backup queue.

4. Subsequent backup streams start backing up data when the backup adds files to
the backup queue. The Avamar Plug-in for Lotus Domino issues a warning if you
add or delete files after a backup stream starts processing the backup queue.
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Queue-based backups
For queue-based backups, the Avamar Plug-in for Lotus Domino uses a single queue
instead of multiple queues.

The following figure shows the process flow for a queue-based backup streams.
Figure 10 Queue-based backup streams

The backup process flow for queue-based backups proceeds as follows:

1. The Avamar Plug-in for Lotus Domino spawns a directory-walker process that
accesses the dataset and determines what files to add to the queue.

2. The Avamar Plug-in for Lotus Domino starts backup threads which are based on
the number of backup streams you specify.

3. The backup threads remove files from the queue, and then back up the files to the
Avamar server or Data Domain system.

Volume-based backups
For volume-based backups, the Avamar Plug-in for Lotus Domino uses a separate
backup stream for each volume. Backup speed depends on whether you configure
each volume on a separate disk or whether you configure multiple volumes on a single
disk.

Backups of multiple volumes on multiple disks provide faster backup speeds than
multiple volumes on a single disk. The following figure shows a configuration in which
each file system resides on a single disk.
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Figure 11 Multiple volumes and multiple backup streams

Excessive seek times can negatively impact the backup speed of multiple volumes on a
single disk.

The following figure shows a single disk that contains two volumes.

Figure 12 Single volume and multiple backup streams

The following scenarios show how backup performance varies depending on the
configuration.

Example 1  Backup scenario 1

The following backup scenario refers to the configuration details in Figure 11 on page
94.

1. The user selects C:/Data for the backup.

2. The C:/Data directory contains three links to C:/Data1, D:/Data, and E:/
Data.

Note

C:/Data1, D:/Data, and E:/Data comprise a dataset.

3. The Avamar Plug-in for Lotus Domino uses three parallel backup streams for this
dataset. One for each for logical volume (C, D, and E).

4. The user selects the number of streams for the backup:

l One stream—The Avamar Plug-in for Lotus Domino runs one stream. Three
separate avtar processes start sequentially to back up data on volumes C, D,
and E. Each volume uses a separate p_cache2.dat file.

l Two streams—The Avamar Plug-in for Lotus Domino runs two streams in
parallel: one stream for volume C and one stream for volume D. After a stream
finishes, a new stream for E starts. The Avamar Plug-in for Lotus Domino uses
a maximum of two streams at any point during the backup.
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Example 1  Backup scenario 1 (continued)

l Three streams—The Avamar Plug-in for Lotus Domino runs three steams in
parallel: one stream for each volume (C, D, and E).

l Four or more streams—The Avamar Plug-in for Lotus Domino runs three
streams in parallel: one stream for each volume (C, D, and E).

The Avamar Plug-in for Lotus Domino uses one stream for each volume. When the
number of streams you select exceeds the number of volumes in the backup, the
Avamar Plug-in for Lotus Domino automatically adjusts the number of streams to
equal the number of volumes in the backup.

Example 2  Backup scenario 2

The following backup scenario refers to the configuration details in Figure 12 on page
94.

1. The user selects C:/Data for the backup.

2. The C:/Data directory does not contain directory or database links. The C:/
Data directory is the only directory for the backup.

3. Because C:/Data is configured on a single volume, the Avamar Plug-in for Lotus
Domino uses one backup stream regardless of whether you specify more than one
backup stream.

Transaction log backups
The Avamar Plug-in for Lotus Domino can use multiple backup streams to back up
transaction logs. The Avamar Plug-in for Lotus Domino backs up transaction logs
along with database files or when you select an incremental backup.

The following figure shows the process flow of transaction log backups that use
multiple backup streams.
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Figure 13 Backup streams for transaction log backups

In Figure 13 on page 96, the Avamar Plug-in for Lotus Domino uses four backup
threads to back up the transaction logs:

1. An Avamar Plug-in for Lotus Domino thread writes the transaction logs paths to a
queue.

2. Each backup thread removes a transaction log path from the queue, and then
backs up the transactions logs to the Avamar server or Data Domain system.

Backup Performance Optimization

96 Avamar for Lotus Domino 7.5.1  User Guide



APPENDIX A

Plug-in Options
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How to set plug-in options
Plug-in options enable you to control specific actions for on-demand backups,
restores, and scheduled backups. The plug-in options that are available depend on the
operation type and the client plug-in type.

Specify the plug-in options in Avamar Administrator for on-demand backup or restore
operations, or when creating a dataset for a scheduled backup. Set plug-in options
with the graphical user interface (GUI) controls (text boxes, checkboxes, radio
buttons, and so forth). In addition to using the GUI controls, you can type an option
and its value in the Enter Attribute and fields for special circumstances.

Note

The Avamar software does not check or validate the information that you type in the
Enter Attribute and Enter Attribute Value fields. In addition, the values in the Enter
Attribute and Enter Attribute Value fields override settings that you specify with the
GUI controls.

Detailed instructions on how to access and set plug-in options during a backup or
restore are available in Backup on page 45 and Restore and Recovery on page 57.

Backup options
Backup plug-in options enable you to control backup functionality that is specific to
the Avamar Plug-in for Lotus Domino. You can specify plug-in options for on-demand
and scheduled backups.

The following table lists options that are available for the Avamar Plug-in for Lotus
Domino when you perform an on-demand backup or when you configure a dataset for
scheduled backups.

Table 8 Backup options

Setting Description

Backup label Assigns a descriptive label to the backup.

Follow links Backs up databases and directories pointed to by links.

Backup type Specifies the type of backup:

l Full—Back up all databases and files that are required for a complete
recovery.

l Incremental—Back up transaction logs and new database files that are
created since the last full or incremental backup.
The Avamar Plug-in for Lotus Domino supports incremental backups only
when you set transaction logging to Archived on the Domino server.

l Subset—Back up selected database files.

Enable debugging messages Writes maximum information to log files. This option can create large log files.

Full path of the Domino server’s notes.ini file Specifies the full pathname of the notes.ini file on the Domino server.
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Table 8 Backup options (continued)

Setting Description

l On Windows, the default folder is C:\Program Files\IBM\Lotus
\Domino.

l On AIX, Linux, or UNIX, the default directory is /data/notesdata/.

Full path of the Domino directory Specifies the full pathname of the Domino directory.

Domino username Specifies the Domino username. This username is the OS user, who has
permissions to start and stop the Domino server on an AIX, Linux, or UNIX
system. The default username is notes.

Note

This field is specific to the AIX, Linux, and UNIX operating systems.

Maximum number of backup streams Specifies the number of backup streams to use. The maximum number is 10.
The default is 1.

Balance data among the streams which are
based on logical volume or file system

Assigns individual volumes or file systems to streams.

Balance data among the streams which are
based on total file size

Assigns files to streams. Each stream receives an equal fraction of the total
file size.

Back up transaction logs with full backup Includes transaction logs with the backup. This option is selected by default.

Archive transaction logs Archives transaction logs after the backup completes. This option is selected
by default.

Terminate backup on error Terminates the backup if an error occurs.

Store backup on Data Domain system Stores the backup on a Data Domain system instead of the Avamar server.

Encryption method to Data Domain system Specifies the encryption method for data transfer between the client and the
Data Domain system during the backup.

Restore options
Restore plug-in options enable you to control restore functionality that is specific to
the Avamar Plug-in for Lotus Domino. Set restore options manually from the Restore
Command Line Options dialog box.

The following table lists options for restore operations with the Avamar Plug-in for
Lotus Domino.

Table 9 Restore options

Setting Description

Bring all databases online after restore Automatically brings all databases online following a successful restore. This
option is selected by default.

Overwrite database files Overwrites existing databases or files with the restored data. Clear this option
to prevent the restore operation from overwriting existing database or files.
The log entries include databases that were not restored. By default, this
option is not set.
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Table 9 Restore options (continued)

Setting Description

Domino username Specifies the Domino username. This username is the OS user, who has
permissions to start and stop the Domino server on an AIX, Linux, or UNIX
system. The default username is notes.

Note

This field is specific to the AIX, Linux, and UNIX operating systems.

Enable debugging messages Do not set this option unless instructed to do so by Avamar Customer Support
personnel. This option writes maximum information to log files, which can
create large log files.

Restore system databases Restores the system databases. Stop the Domino server to restore system
databases. System databases include busytime.nsf, ddm.nsf,

events4.nsf, log.nsf, mail.box, names.nsf, and mailjrn.nsf.

Specifies full paths for the Domino
configuration file and directory

Enables the restore operation to use the pathnames that are specified by the

Full path of the Domino server’s notes.ini file and Full path of the
Domino directory fields. This option is necessary only if the Lotus Domino
configuration has changed or the Domino server has been reinstalled in a new
location. In these instances, you must provide the current pathnames to
restore database files.

Note

A restore operation by default uses the same pathnames for the notes.ini
file and Domino directory as the ones that the backup uses.

Full path of the Domino server’s notes.ini file Specifies the full pathname to the notes.ini file on the Domino server.

l On Windows, the default folder is C:\Program Files\IBM\Lotus
\Domino.

l On AIX, Linux, or UNIX, the default directory is /data/notesdata/.

Full path of the Domino directory Specifies the full pathname to the Domino configuration file and directory:

l On Windows, the default folder is C:\Program Files\IBM\Lotus
\Domino\.

l On AIX, the default directory pathname is /opt/ibm/lotus/notes/
80010/ibmpow/.

l On Linux, the default directory pathname is /opt/ibm/lotus/notes/
85020/linux/.

Pause replication of restored databases Temporarily disable the replication of the successfully restored databases.
This option allows you to check or verify the status of the restored databases
before the databases are copied or synced to other replicas. By default, this
option is not set.

Note

After checking or verification, you should manually re-enable the replication
those databases via the Avamar Administrator GUI.
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Table 9 Restore options (continued)

Setting Description

Encryption method from Data Domain system Specifies the encryption method for data transfer between the Data Domain
system and the client during the restore.

Recover the databases by using transaction
logs

Enables the restore operation to use transaction logs to recover database files
to a specific date and time. This option is selected by default.

Recover all databases as one group per
stream

Recovers all databases in groups rather than one at a time. If a database
encounters a problem during a group recovery, the recovery fails for all
databases in that group. This option is intended for advanced users who are
familiar with the recovery of Domino databases.

Create DBIID during recovery Enables the Domino server to assign new DBIIDs to databases that are
recovered. This option is not selected by default. Because database
transactions are specific to the DBIID, you cannot apply transaction logs
before the recovery. Avamar recognizes a database with a new DBIID as an
entirely new database.

Create DBIID and ReplicaID during recovery Enables the Domino server to assign new DBIIDs and ReplicaIDs to databases
that are recovered. This option is not selected by default. Because
transactions are specific to the DBIID, you cannot apply transaction logs
before the recovery. Avamar recognizes a database with a new DBIID as an
entirely new database.

Now Restores each database to its original state at the time of the backup. Then,
transaction logs are used to recover all data until now. This option is selected
by default.

Other date/time Restores each database to its original state at the time of the backup. Then,
transaction logs are used to recover all data up to the date and time you

specify in the Recover date/time (yyyy-mm-dd hh:mm:ss) field.

Backup date/time Restores each database to its original state at the time of its backup.

Note

When backing up multiple databases in a single backup, the backup time
differs for each database.

Recover date/time (yyyy-mm-dd hh:mm:ss) Specifies the calendar date to which the data is recovered when you select

the Other date/time option. The entry must be in the following format:
yyyy-mm-dd hh:mm:ss:mmm

where:

l yyyy is a four-digit year.

l mm is a two-digit month of the year.

l dd is a two-digit day of the month.

l hh is a two-digit hour of the day.

l mm is the two-digit number of minutes past the hour.

l ss is the two-digit number of seconds past the minute.

Dashes (-) must separate year, month, and day. Colons (:) must separate
hours, minutes, and seconds. You can truncate the time entry. For example,
you can omit minutes and seconds.
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Table 9 Restore options (continued)

Setting Description

Restore missing NLO files Restores missing NLO files that are referenced by the databases that are
successfully restored. This option is selected by default. The process of
finding NLO files might take a long time.

Synchronize DAOS catalog files Synchronizes the DAOS catalog file. The process of synchronizing the DAOS
catalog file might take a long time.

Synchronize DAOS catalog files normally Synchronizes the DAOS catalog file. Selecting this option performs the
following tasks:

l Builds the DAOS ID Table (DIT) and the DAOS Object Index (DOI).

l Scans all databases for NLO file references. If no references are found for
an NLO file, the NLO file is marked for deletion.

Synchronize DAOS catalog files using QUICK
(Domino version 8.5.2 or later)

Creates a DIT and DOI in the DAOS catalog. This option does not synchronize
the DAOS catalog files. To synchronize the DAOS catalog files, select the

Synchronize DAOS catalog files normally option.

Transaction log pre-fetch value Denotes the number of transaction logs that should be pre-fetched during
recovery operation, which improves recovery speed. The default is 5, and the
maximum is 100.
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Troubleshooting backup problems
You can resolve some backup problems with the troubleshooting information in this
appendix.

Backing up Lotus Domino temporary files fails
The Domino server creates temporary files (*.TMP and *.sh) in the data directory.

When the files are no longer needed, the Domino server deletes the temporary files.
An Avamar Plug-in for Lotus Domino backup returns an error if the Domino server
deletes temporary files while the backup is processing the temporary files directory:

Path does not exist
You can ignore this error.

To prevent backups from returning this error, set up an exclusion list to exclude the
Domino server’s temporary files from the backup. The Avamar Administration Guide
provides more information about exclusion lists.

Backup terminated due to timeout
A backup can fail when the backup time exceeds the value you specify for the
BACKUP_TIMEOUT parameter in the notes.ini file.

A backup of a Domino database fails and returns the following error:

<DATABASE-NAME>Backup terminated due to timeout
This problem occurs when the backup time exceeds the value you specify for the
BACKUP_TIMEOUT parameter in the notes.ini file. The default value for
BACKUP_TIMEOUT is set to 15 minutes even if you do not include this parameter in
the notes.ini file.

To resolve this problem, increase the BACKUP_TIMEOUT setting to 60 minutes:

1. Log in to the Domino server.

2. Open the \path\notes.ini file in a text editor.
where path is the full directory pathname to the notes.ini file.

3. Set the BACKUP_TIMEOUT parameter to 60 minutes:
BACKUP_TIMEOUT=60

4. Save the changes, and then close the text editor.

5. Restart the Domino server twice for the configuration changes to take effect.

Note

You can prevent a backup from timing out by setting the BACKUP_NO_TIMEOUT
parameter to 1. A value of 1 can cause a backup to run continuously. Use only one of
these parameters (BACKUP_TIMEOUT or BACKUP_NO_TIMEOUT) in the notes.ini
file.

The Lotus Domino documentation provides more information about the
BACKUP_TIMEOUT and BACKUP_NO_TIMEOUT parameters.
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Database compaction fails during backup
Do not back up an online database during a database compaction. Database
compaction can fail during an online backup.

Path does not exist
An Avamar Plug-in for Lotus Domino backup can fail if you delete temporary files
before they are backed up.

A backup of the Domino data directory returns the error:

Path does not exist
The backup returns this error if an Avamar Plug-in for Lotus Domino backup processes
a directory with temporary files that are deleted before they are backed up. The
Domino server creates temporary files (*.TMP and *.sh) in the data directory and
later deletes these files.

You can ignore this error. To prevent backups from returning this error, set up an
exclusion list that specifies the Domino server’s temporary files. The Avamar
Administration Guide provides more information about setting up exclusion lists.

Troubleshooting restore problems
You can resolve some restore problems with the troubleshooting information in this
appendix.

Access to database denied
The Avamar Plug-in for Lotus Domino returns an access denied error when you restore
ExBadDoc.ntf.

The installation of EmailXtender
®

 on a Domino server creates a read-only database file
named ExBadDoc.ntf. If you restore ExBadDoc.ntf, the Avamar Plug-in for Lotus
Domino returns an error:

Access to database denied
To restore ExBadDoc.ntf, you must first delete it, and then restore it by using the
Avamar Plug-in for Lotus Domino. Restore and Recovery on page 57 provides more
information about restoring database files.

Backup was later than recovery point in time
If you specify a time for the Recover date/time option that is after the original
backup time, the recover fails.

When you set the Recover date/time option to a time before the original backup
time, a restore fails with the following error:

Recovery Failed reason:Recovery Manager: Backup was later than
recovery point in time.
To resolve this problem, specify a time for the Recover date/time option that is after
the original backup time. Restore and Recovery on page 57 provides more information
about restoring Domino database files, and Plug-in Options on page 97 provides more
information about the Recover date/time option.
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Could not create directory
Restoring database files to a different (target) directory other than the original
directory fails if the target directory does not have read and write permissions for the
Domino user account.

The error message that the restore operation returns is similar to the following error:

2012-01-18 21:25:22 avtar Error <6745>: Could not create
directory "/dir1" for restore (code 13: Permission denied)
Ensure that the target directory has read and write permission for the Domino user
account. The Domino server uses this user account (by default, “notes”) for tasks
such as starting and stopping the Domino server.

Database is in use and cannot be taken offline
You cannot restore an online shared mail database.

When a shared mail database is online, a restore of a shared mail database file fails and
returns a message similar to the following error message:

5098 -> The database is in use and cannot be taken off-line
A shared mail database cannot be taken offline.
To restore a shared mail database file, use the instructions in Restoring shared mail
databases on page 72.

Domino server not reachable or not running
The Avamar Plug-in for Lotus Domino cannot synchronize the DAOS catalog file when
the server is not reachable.

When the server is not reachable during a DAOS synchronization process, the
following error can appear in the log file:

Unable to find path to server.
The DAOS synchronization process requires the Domino server to be online.

Check network connectivity from the Avamar server to the Domino server. If the
network connection is working, use the Lotus Domino trace option to further diagnose
the problem:

l On a Notes client, select File > Preferences > User Preferences > Ports > Trace.

l On the Domino server, use the Trace command.

Restoration of missing NLO files not supported
A restore operation that specifies the Restore of Missing NLO files advanced option
fails to restore NLO files if the Bring all databases online after restore advanced
option is not selected.

When this failure occurs, the Avamar log file contains the following error:

Restoration of missing NLO files not supported for the
databases which are selected to be brought offline after
restore/recover
The database must be online to restore the NLO files.
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To restore NLO files, select the Bring all databases online after restore and Restore
of Missing NLO files options.

Restoring databases on DAOS-enabled servers on page 70 provides more information
about restoring NLO files.

Recovery Manager: Database is not latest copy
A database restore operation fails if the database is not set to ARCHIVE mode and if
you specified the Recover the database by using transaction logs options.

When a database recovery fails, the following error message appears in the log file:

<8163>: Recovery Failed reason: Recovery Manager: Database is
not latest copy.
The restore operation reports this error message if the following conditions are true:

l You attempted to restore a backup of a database that does not have transaction
logging which is set to ARCHIVE mode.

l You specified the Recover the database by using transaction logs option in the
Restore Command Line Options dialog box.

Note

The Recovery the database by using transaction logs option is enabled by default.

To resolve this issue, restore the database without using transaction logs:

1. In the Restore Options dialog box, click More Options.

2. Select Show Advanced Options to display the advanced plug-in options.

3. Clear Recover the database by using transaction logs.

4. Click OK to close the Restore Options dialog box. The following status message
appears:

Restore initiated.
5. Click OK to start the restore.

Recovery Manager: Recovery only supported for backup files

A recovery of a deleted database fails with the following error:

avlotus Error <19258>: /local/notesdata/notes.nsf Recovery
Failed reason: Recovery Manager: Recovery only supported for
Backup Files.. Try to recover this file after some time
This problem occurs when you delete a database by using the rm command on a Linux
or UNIX system while the Domino server is running, and then perform a recovery of
the deleted database. The error message uses the notes.nsf database as an
example.

There are two workarounds for this issue. Workaround 1 requires you to restart the
Domino server. Workaround 2 does not require you to restart the Domino server.

Workaround 1

1. Restart the Domino server.

2. Perform a recovery of the deleted database.

3. Restart the Domino server.
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Workaround 2

1. From the Domino Console, run the dbcache flush command.

2. Perform a recovery of the deleted database.

IBM documentation for Domino provides more information about the Domino Console
and dbcache flush command.

Troubleshooting configuration problems
You can resolve some configuration problems with the troubleshooting information in
this appendix.

Backup or restore requires I18n Domino server
You must install the Domino server on a system that supports UTF-8 encoding.

To ensure that the system supports UTF-8 encoding, check the following items:

l The locale settings for the Domino server on Windows platforms.
l The LANG variable in the .bash_profile file for AIX, Linux, and UNIX systems.

If required, add the LANG variable to the .bash_profile file for the Domino notes
user.

Fatal signal 11 in pid 1543 error on AIX 64-bit client
On a 64-bit AIX 6.1 system, an Avamar Plug-in for Lotus Domino backup or restore can
fail with a Fatal signal 11 error.

The avlotus log file contains additional errors similar to the following output:

2014-05-15 03:54:22 avlotus Info <5241>: Logging to
/usr/local/avamar/var/MOD-1283153278629-5014-lotus.log
2014-05-15 03:54:22 avlotus Info <6636>: CTL listening on port
32796
2014-05-15 03:54:22 avlotus Info <0000>: Setting ctl message
version to 2 (from 1)
2014-05-15 03:54:23 avlotus Info <9209>: Exclude list file is
2014-05-15 03:54:23 avlotus Info <9211>: Include list file is
2014-05-15 03:54:23 avlotus Info <8038>: Avlotus Incremental
Backup request
2014-05-15 03:54:23 avlotus Info <6649>: Process 442484
(/usr/local/avamar/bin/avtar) for workorder MOD-1283153278629
started
2014-05-15 03:54:23 avlotus Info <8047>: Notes.ini Path =
/home/notes/notesdata/notes.ini
2014-05-15 03:54:23 avlotus Info <9230>: Lotus Domino
executable
directory full path = /opt/ibm/lotus/notes/85000/ibmpow/
2014-05-15 03:54:23 avlotus Info <8175>: Loading the Notes/
Domino
library /opt/ibm/lotus/notes/85000/ibmpow/libnotes_r.a
2014-05-15 03:54:23 avlotus FATAL <5889>: Fatal signal 11 in
pid 1543
2010/08/30-08:54:23.55983 [AvLotusBackupMgr] FATAL ERROR:
<0001>
Fatal signal 11
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2010/08/30-08:54:23.56015 [AvLotusBackupMgr] ERROR: <0316>
handlefatal exiting thread
pid=1543, sig=11
2014-05-15 03:54:23 avlotus Error <5891>: handlefatal: exiting
thread
pid=1543, sig=11
2014-05-15 03:54:24 avlotus Info <0000>: Setting ctl message
version
o 2 (from 1)
The following procedure resolves this issue:

1. Shut down the Domino server.

2. Reboot the AIX system.

3. Log in to the AIX system as root.

4. Stop avagent by typing the following command:

/usr/local/avamar/etc/avagent.d --stop
5. Change the value of maxDATA in avagent.bin to 0x00000000 by typing the

following command on one line:

/usr/ccs/bin/ldedit -bmaxdata:0x00000000/usr/local/avamar/bin/
avagent.bin

Output similar to the following appears in the command shell:

/usr/ccs/bin/ldedit: File AvamarInstallDir/bin/avagent.bin
updated.

6. Verify that the value for maxDATA is 0x00000000 by typing the following
command:

dump -o /usr/local/avamar/bin/avagent.bin

The following output appears in the command shell:

maxDATA
0x00000000

7. Start avagent by typing the following command:

/usr/local/avamar/etc/avagent.d --start

Two Domino restarts after configuration changes
You might have to restart the Domino server twice after you change its configuration
settings. In addition, you might have to reboot the hardware that runs the Domino
server. The IBM Lotus Domino technote 1381136 provides more information.

Unable to initiate Lotus API
When a Domino server is configured with a secured (password-protected) console,
the Avamar Plug-in for Lotus Domino cannot back up or restore the Lotus databases.

Backups and restores fail and report the following error:

Unable to initiate lotus API
To back up and restore a Domino server with the Avamar Plug-in for Lotus Domino,
remove the password protection for the Domino server console by using the Domino
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Administrator program or the Set Secure command. The Domino Administrator
online help provides instructions on removing password protection.
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Overview of the CLI for Avamar Plug-in for Lotus Domino
The Avamar Plug-in for Lotus Domino provides a command-line interface from which
you can back up or restore Lotus Domino database files by using the avlotus
command. You can use the CLI from all operating systems that the Avamar Plug-in for
Lotus Domino supports.

The avlotus command, which is available as a binary or executable, is located in the
installation directory:

l For AIX or Linux systems, the avlotus binary is located in /usr/local/
avamar/bin.

l For a Solaris system, the avlotus binary is located in /opt/AVMRclnt/bin.

l For a Windows system, the avlotus executable is located in C:\Program
Files\avs\bin.

You run the avlotus command from the system prompt on AIX, Linux, or UNIX
systems, or from the Command Prompt window on a Windows system.

Backup and restore limitation
Do not run a backup or restore operation from the CLI at the same time a backup or
restore operation is running from Avamar Administrator. Doing so might cause a race
condition between the two processes.

Canceling a backup or restore from the CLI
When you start a backup or restore from the CLI, do not cancel the process by using
SIGINT (Ctrl+c, Ctrl+d, or Ctrl+z). The Domino server can crash if you send a
SIGINT signal or close a session while a backup is running from the CLI.

To cancel a CLI backup or restore operation, stop the avtar process by using the
appropriate method:

Procedure

l On AIX, Linux, or UNIX, use the kill command to stop the avtar process.

l On Windows, stop the avtar.exe process from the Processes tab in the
Windows Task Manager.

Command reference
The avlotus command backs up or restores Lotus Domino database files.

Synopsis

avlotus --operation={backup | restore} [options]
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Operations
The avlotus command works with two operation functions: backup and restore.
Specify an operation with the avlotus command by using the --operation option.

Note

The avlotus command does not include a browse operation. To view files for backup
or restore, use the operating system shell for AIX, Linux, or UNIX and the Windows
Explorer for Windows.

The following table lists the operations that you can specify with the avlotus
command by using the --operation option.

Table 10 Operations for the avlotus command

Command Description

backup Performs an on-demand backup of Lotus
Domino data to the Avamar server.

restore Restores the Lotus Domino data to the
original location or to a different location
(redirected restore).

Options
The options that you specify with the avlotus command control backup and restore
operations. The Avamar Plug-in for Lotus Domino supports five types of options:
common, account, logging, backup, and restore. The Avamar Plug-in for Lotus Domino
does not support browse options.

Common options
Common options are general options that are available for multiple operations.

The following table lists common options for the avlotus command.

Table 11 Common options for the avlotus command

Option Description

--exclude-pluginid-list=list Excludes backups that are originally taken with one
or more plug-in types, where list is a comma-
separated list of one or more integer plug-in IDs.

--pluginid-list=list Includes backups that are originally taken with one
or more plug-in types, where list is a comma-
separated list of one or more integer plug-in IDs.

--version Displays the build version.

--domino-user=username Specifies the Domino username. This username is
the OS user, who has permissions to start and stop
the Domino server on an AIX, Linux, or UNIX
system.
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Table 11 Common options for the avlotus command  (continued)

Option Description

--exec-dir-path=filepath Specify the full path for the Domino configuration
file and directory:

l On Windows, the default folder is C:\Program
Files\IBM\Lotus\Domino\.

l On AIX, the default directory path
is /opt/ibm/lotus/notes/80010/
ibmpow/.

l On Linux, the default directory path
is /opt/ibm/lotus/notes/85020/linux/.

--flagfile=filepath Specifies an option file, where filepath is the full

path and the file name of the option file.

--notesini-path=filepath Specifies the full path to the notes.ini file on the

Domino server:

l On Windows, the default folder is C:\Program
Files\IBM\Lotus\Domino\data\.

l On AIX, Linux, or UNIX, the default directory
is /local/data/notesdata/.

Account options
Account options enable you to specify credentials to connect to the Avamar server for
backups and restores that you perform with the avlotus command.

The following table lists account options for the avlotus command.

Table 12 Account options for the avlotus command

Option Description

--account=location |

--path=location |

--acnt=location

Specifies a hierarchical location on the Avamar
server. This option is relative to the current home
location, unless you use a slash (/) as a prefix to the
path designation, in which case an absolute path is
assumed.

--id=user@domain/homeacnt Specifies the client username for authentication
where:

l user is the username of the registered client.

l domain is the Avamar domain.

l homeacnt is the hostname of the Avamar Plug-
in for Lotus Domino host.

--password=password |

--ap=password |

--pswd=password

Specifies the password for --id=user@domain/
homeacnt.
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Table 12 Account options for the avlotus command  (continued)

Option Description

--server=Avamar_server
--hfsaddr=Avamar_server

Specifies the Avamar server IP address or fully
qualified hostname (as defined in DNS).

Logging options
Logging options enable you to specify the directory path for log files and to control
the output that the avlotus command writes to standard output or to log files.

The following table lists logging options for the avlotus command.

Table 13 Logging options for the avlotus command

Option Description

--informationals Sets the information level for status messages.

--logfile=file | --log Creates log files in the directory that you
specify.

--noinformationals Disables informational messages.

--nostdout Disables output to standard output (stdout).

--nowarnings Disables warning messages.

--quiet Disables both warnings and status messages.

--verbose | --verbose=n | -v Enables all status and warning messages. Use --
verbose=n to specify a verbosity level, where n
is a number from 1 to 6 with 6 being the highest
level of verbosity.

Backup options
Backup options for the avlotus command enable you to control specific behavior of
a backup, such as specifying a backup level or excluding certain files from a backup.

The following table lists backup options for the avlotus command.

Table 14 Backup options for the avlotus command

Option Description

--32bitbinary To back up data from the 32-bit version of Domino
server on AIX systems, you must specify the
32bitbinary flag.

--expires={days|timestamp} Specifies the backup expiration date as a number of
days from the day of the backup (days) or an absolute
timestamp (timestamp). Specify timestamp by using
24-hour local time zone values conforming to the
following syntax:

yyyy-mm-dd hh:mm:ss
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Table 14 Backup options for the avlotus command (continued)

Option Description

You can specify partial date strings. For example,
2014-02 is equivalent to 2014-02-01 00:00:00.

--group-by-size Assigns files to streams. Each stream receives an
equal fraction of the total file size.

--group-by-volume Assigns individual streams to each volume.

--label=name Specifies a label name for the backup.

--retention-type=type Specifies one of the following retention types: none,

daily, weekly, or monthly.

--archive-txn-logs Backs up the archive transaction logs. Specify true
or false. The default value is true. To perform a full

backup without the archive logs, specify --
archive-txn-logs=false with the avlotus
command.

Note

Do not use the --archive-txn-logs option with

an incremental backup.

--backup-txn-logs Backs up transaction logs. Specify true or false.

The default value is true.

--backup-type=type Specifies the type of backup:

l 0 (full)—Backs up all databases and files that are

required for a complete recovery. Default backup
type.

l 1 (incremental)—Backs up transaction logs and

new database files that are created since the last
full or incremental backup.

l 2 (subset)—Backs up a subset of database files.

--exclude=pattern Excludes files that match a specific pattern from the
backup. Use pattern to specify a string, which can
include wildcard characters such as the asterisk (*)
and question mark (?).

--exclude-from=file Specifies a file that lists patterns to use to exclude
files from the backup. When a file matches a pattern,
the backup excludes the file. A pattern can include
wildcard characters such as the asterisk (*) and
question mark (?).

--follow-links Following links to back up databases and directories.
Specify true or false. The default value is true.

--include=pattern Includes files that match a specific pattern in the
backup. Use pattern to specify a string, which can
include wildcard characters such as the asterisk (*)
and question mark (?).
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Table 14 Backup options for the avlotus command (continued)

Option Description

--include-from=file Specifies a file that lists patterns to use to include
files in the backup. When a file matches a pattern, the
backup includes the file.

--terminate-on-error Skips the file if the backup returns an error. Specify
true or false. The default value is false.

Restore options
Restore options for the avlotus command enable you to control specific behavior of
a restore, such as synchronizing DAOS catalog file or overwriting existing databases
or files.

The following table lists restore options for the avlotus command.

Table 15 Restore options for the avlotus command

Option Description

--label=name Specifies the label name for the backup.

--labelnum=name Specifies the label number of the backup to
restore.

--bring-online Automatically brings all databases online
following a successful restore. Specify true or

false. The default value is true.

--enable-recovery Recovers the databases after the restore
operation completes. Specify true or false.

The default value is true.

--normal-sync-daos Synchronize the DAOS catalog file:

l Builds the DAOS ID Table (DIT) and the
DAOS Object Index (DOI).

l Scans all databases for NLO file references.
The restore marks an NLO file for deletion if
the restore does not find references for an
NLO file.

Specify true or false. The default value is

true.

--overwrite-files Overwrites existing databases or files with the
restored data. Specify true or false. The

default value is false.

-- pausereplica Temporarily disable the replication of the
successfully restored databases. Specify true or

false. The default value is false.

--quick-sync-daos Synchronizes the DAOS catalog files by using the
QUICK option. Specify true or false. The

default value is false.
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Table 15 Restore options for the avlotus command  (continued)

Option Description

Note

The --quick-sync-daos option applies only to

Domino version 8.5.2 and later.

--recover-backuptime Restores each database to its original state at the
time of its backup. Specify true or false. The

default value is false.

--recover-datetime=yyyy-mm-dd
hh:mm:ss

Specifies the calendar date for the recover. Use
the following format to specify the date and time:
yyyy-mm-dd hh:mm:ss:mmm

where:

l yyyy is a four-digit year.

l mm is a two-digit month of the year.

l dd is a two-digit day of the month.

l hh is a two-digit hour of the day.

l mm is the two-digit number of minutes past
the hour.

l ss is the two-digit number of seconds past
the minute.

Dashes (-) must separate year, month, and day.
Colons (:) must separate hours, minutes, and
seconds. You can truncate the time entry. For
example, you can omit minutes and seconds.

--recover-in-batch Recovers the databases in batch. Specify true
or false. The default value is false.

--recover-now Restores each database to its original state at the
time of the backup. Then, the restore uses
transaction logs to recover all data until now.
Specify true or false. The default value is

true.

--recover-othertime Restores each database to its original state at the
time of the backup. Then, the restore uses
transaction logs to recover all data up to the date
and time that you specify by the --recover-
datetime option. Specify true or false. The

default value is false.

--refresh-dbiid Assigns new DBIIDs to databases that you
recover. Specify true or false. The default

value is false.

--refresh-replicaid Assigns new ReplicaIDs to databases that you
recover. Specify true or false. The default

value is false.

Command-Line Interface

118 Avamar for Lotus Domino 7.5.1  User Guide



Table 15 Restore options for the avlotus command  (continued)

Option Description

--restore-missing-nlo Restores missing NLO files from the Domino
server. Specify true or false. The default value

is true.

--restore-system-dbs Restore system databases. Specify true or

false. The default value is false.

--sync-daos-catalog Synchronizes the DAOS catalog files after
restoring Domino files. Specify true or false.

The default value is false.

--target=path Restores the database to a different directory on
the original client. The path is the destination
directory.

--translogprefetch=n Instructs the plug-in to fetch more than one
transaction log at a time. The number of logs
fetched at one time is set by n; a maximum of 100
is allowed.

Help option
The --help option displays a list of available operations and options for the avlotus
command.

To view a complete list of operations and options with a description for each one, use
the --help option with the avlotus command:

avlotus --help
To view only the options for a specific operation, use the --help and --
operation=operation options together. The following command provides a list of
options for the backup operation:

avlotus --help --operation=backup
When you include the --debug option in the avlotus.cmd file, the avlotus --
help command displays debug messages. To prevent debug messages from appearing
in online help content use the following command:

avlotus --help --debug=false

Specifying command line options
You can specify options for avlotus to control backup or restore behavior. You can
specify options for avlotus on the command line or in a file that affects both GUI
and CLI usage. The default name for this file is avlotus.cmd.

The avlotus.cmd file is located in the following directory:

l For AIX or Linux, in /usr/local/avamar/var/clientlogs
l For a Solaris system, in /opt/AVMRclnt/var/clientlogs
l For Windows, in C:\Program Files\avs\var\clientlogs
List each option on its own line, as shown in the following example:
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--verbose=5
--x14=65535

Create the avlotus.cmd file as a text file. If you want to give it a different name, or
place it somewhere else, you can specify the option file on the command line using the
--flagfile=<filepath> option. In this case <filepath> is the full path of the
option file.

CLI example commands
The avlotus command uses the default value for an option unless you specify
otherwise. For example, the --backup-txn-logs option is true by default. The
avlotus command uses this option without you having to include it. You need only
include the --backup-txn-logs option in the command line to specify false.

The following examples show how to use the avlotus command to back up data to
the Avamar server and to restore data back to the client.

Note

The avlotus command requires the --domino-user option only for AIX, Linux, or
Solaris.

Example backup commands
These commands illustrate how to use the avlotus command to back up Domino
files to the Avamar server.

Backing up all Domino files and the transaction logs

The following command uses the --backup-type=0 option to perform a full backup
that includes transaction logs:

avlotus --operation=backup --backup-type=0 --id=user@domain/homeacnt
--password=password --server=address --logfile=file
--notesini-path=/local/notesdata/notes.ini
--exec-dir-path=/opt/ibm/lotus/notes/85020/linux/
--domino-user=notes /local/notesdata

Note

Because the default value for the --backup-txn-logs and --archive-txn-logs
options is true, the avlotus command does require you to include them.

Backup types on page 20 provides more information about full backups.

Backing up all Domino files without transaction logs

The following command uses the --backup-type=0 and --backup-txn-
logs=false options to perform a full backup that does not include the transaction
logs:

avlotus --operation=backup --backup-type=0 --id=user@domain/homeacnt
--password=password --server=address --logfile=file
--notesini-path=/local/notesdata/notes.ini
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--exec-dir-path=/opt/ibm/lotus/notes/85020/linux/
--domino-user=notes --backup-txn-logs=false /local/notesdata

Backing up only Domino files that have changed

The following command uses the --backup-type=1 option to perform an
incremental backup:

avlotus --operation=backup --backup-type=1 --id=user@domain/homeacnt
--password=password --server=address --logfile=file
--notesini-path=/local/notesdata/notes.ini
--exec-dir-path=/opt/ibm/lotus/notes/85020/linux/
--domino-user=notes --archive-txn-logs=false /local/notesdata

Note

You cannot back up archive logs with an incremental backup. You must specify the --
archive-txn-logs=false option.

Backup types on page 20 provides more information about incremental backups.

Subset backup

The following command uses the --backup-type=2 to perform a subset backup:

avlotus --operation=backup --backup-type=2 --id=user@domain/homeacnt
--password=password --server=address --logfile=file
--notesini-path=/local/notesdata/notes.ini
--exec-dir-path=/opt/ibm/lotus/notes/85020/linux/
--domino-user=notes /local/notesdata/mail/test.nsf

Backup types on page 20 provides more information about subset backups.

Example restore commands

The following examples show how to use the avlotus command to restore Domino
files from the Avamar server.

Restoring Domino files with transaction logs

The following command uses the --enable-recovery and --recover-now
options to recover all data until now.

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata

Note

Because the default value for the --enable-recovery and --recover-now
options is true, the avlotus command does not require you to include them.

Restoring a backup to its original state

The following command uses the --recover-backuptime option to recover the
database to its original state:
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avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --recover-backuptime

Restoring a backup and recovering the database to a point in time

The following command uses the --recover-datetime option to recover the
database to its original state:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata/mail
--recover-datetime="yyyy-mm-dd hh:mm:ss"

Restoring a backup with transaction logs and restoring system databases

The following command uses the --enable-recovery and --recover-now
options to recover all data until now, and uses the --restore-system-dbs option
to restore system databases:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35
--overwrite-files /local/notesdata --restore-system-dbs

Restoring a database without recovering it

The following command uses the --enable-recovery=false option to prevent a
recovery operation:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --enable-recovery=false

Synchronizing the DAOS catalog after restoring the database

The following command uses the --normal-sync-daos option to synchronize the
DAOS catalog after restoring Domino files:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --normal-sync-daos

Recover the databases using log pre-fetch

The following command uses flag the --translogprefetch option to restore using
log pre-fetch options:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --translogprefetch=10

Recover the databases in batch mode

The following command uses flag the --recover-in-batch option to restore all
databases in a single batch:
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avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --recover-in-batch=true

Restoring 100 databases in a single batch

The following command uses the --restore-dbs-single-batch=100 option to
restore 100 databases in a single batch:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --restore-dbs-single-batch=100

Restoring all databases in single batch

The following command uses the --all-dbs-single-batch option to restore all
databases in a single batch:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --all-dbs-single-batch

Restoring Domino files without restoring the missing NLO files

The following command restores Domino files without bringing the database back
online by using the --bring-online=false option and without restoring missing
NLO files by using the --restore-missing-nlo=false option:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --bring-online=false
--restore-missing-nlo=false

Restoring Domino files to a different directory on the original client

The following command uses the --target=path option to restore Domino files to a
different directory on the original client:

avlotus --operation=restore --id=user@domain/homeacnt
--password=password --server=address --labelnum=35 --logfile=file
--overwrite-files /local/notesdata --enable-recovery=false
--target=path

To perform a redirected restore, the avlotus command must include the --
enable-recovery=false option.
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GLOSSARY

 

A

activation The process of passing the client ID (CID) back to the client, where it is stored in an
encrypted file on the client file system.
 
See also client activation

administrator Person who normally installs, configures, and maintains software on network
computers, and who adds users and defines user privileges.

avagent The name of the client agent process.

Avamar Administrator A graphical management console software application that is used to remotely
administer an Avamar system from a supported Windows or Linux client computer.

Avamar client A computer or workstation that runs Avamar software and accesses the Avamar server
over a network connection. Avamar client software comprises a client agent and one or
more plug-ins.

Avamar server The server component of the Avamar client/server system. Avamar server is a fault-
tolerant, high-availability system that efficiently stores the backups from all protected
clients. It also provides essential processes and services required for data restores,
client access, and remote system administration. Avamar server runs as a distributed
application across multiple networked storage nodes.

avtar The Avamar process that performs backups and restores.

 

B

backup A point-in-time copy of client data that can be restored as individual files, selected data,
or as an entire backup.

browse The process of viewing data that is available for backup on a client computer or restore
from the Avamar server.

 

C

client activation The process of passing the client ID (CID) back to the client, where it is stored in an
encrypted file on the client file system.
 
See also activation

client agent A platform-specific software process that runs on the client and communicates with the
Management Console Server (MCS) and with any plug-ins installed on that client.
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client registration The process of establishing an identity with the Avamar server. When Avamar
recognizes the client, it assigns a unique client ID (CID), which it passes back to the
client during client activation.
 
See also registration

cold backup A backup performed while the database is offline.

 

D

DAOS directory A directory that contains NLO files. Domino stores NLO files in subdirectories under the
DAOS directory. The naming convention for the subdirectories is 0001, 0002, and so
forth.

database A collection of data arranged for ease and speed of update, search, and retrieval by
computer software.

dataset A policy that defines a set of files, directories, and file systems for each supported
platform that are included or excluded in backups across a group of clients. A dataset is
a persistent and reusable Avamar policy that can be named and attached to multiple
groups.

DBIID The database instance ID property of a database. This value is located in the database
header and associates the database with specific entries in the transaction log.

disaster recovery Recovery from any disruptive situation, such as hardware failure or software corruption,
in which ordinary data recovery procedures are not sufficient to restore a system and
its data to normal day-to-day operations. A disaster recovery can be a bare metal
recovery.

DNS Domain Name Server. A dynamic and distributed directory service for assigning domain
names to specific IP addresses.

domain A feature in Avamar Administrator that is used to organize large numbers of clients into
named areas of control and management.

Domino Attachment and
Object Service (DAOS)

An attachment consolidation feature available in Lotus Domino 8.5. DAOS substantially
reduces disk space by storing only one copy of an email attachment from an email
message that you send to multiple users. With DAOS enabled, the Domino server no
longer saves a separate copy of every attachment in the user’s email file (NSF).
Instead, the Domino server stores a reference to the file attachment (also referred to as
a ticket) in the object header of the document, and stores a single copy of the file
attachment in an NLO file in the attachment repository on the server.

Domino partitioned
server

A feature that enables you to run multiple instances of the Domino server on a single
computer.

Domino server A computer that runs the Domino Server program and stores Notes databases.
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F

file system Software interface used to save, retrieve, and manage files on storage media by
providing directory structures, data transfer methods, and file association.

full backup A backup that makes copies of the data directory on the Domino server.

 

G

group A level of organization in Avamar Administrator for one or more Avamar clients. All
clients in an Avamar group use the same group policies, which include the dataset,
schedule, and retention policy.

group policy The dataset, schedule, and retention policy for all clients in an Avamar group.

 

H

hot backup A backup that you run while users are online and have access to the data that is being
backed up.

hot restore A restore that runs while the Domino server is running.

 

I

incremental backup A backup that makes copies of the transaction log files, all database files that have been
created since the last full or incremental backup, and all database files for which the
DBIID has changed since the last full or incremental backup.

 

L

LAN Local Area Network.

 

M

MCS Management console server. The server subsystem that provides centralized
administration (scheduling, monitoring, and management) for the Avamar server. The
MCS also runs the server-side processes used by Avamar Administrator.

metadata Data about the backup, including information about the original database files, the
backup types, the date and time of the backup, and other information necessary for
restore.
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N

NLO files Files that store attachment content for email messages (NSF files). An NSF file
contains a reference or ticket to an NLO file. DAOS creates one NLO file for each
attachment. The DAOS directory stores all NLO files. The DAOS configuration creates
the DAOS directory. You can back up the NLO files in the DAOS repository while the
Domino server is down or when it is up and running. The Avamar Plug-in for Lotus
Domino backs up the entire DAOS directory automatically as part of a backup request.

Notes client Client software that enables users to access Lotus Notes applications on a Domino
server, send mail, and browse the Web.

 

P

plug-in Avamar client software that recognizes a particular kind of data resident on that client.

plug-in options Options that you specify during backup or restore to control backup or restore
functionality.

policy A set of rules for client backups that can be named and applied to multiple groups.
Groups have dataset, schedule, and retention policies.

 

R

recover To restore data from a backup to a client disk and apply transaction logs to the data to
make it consistent with a specific point in time.

redirected restore The process of restoring a backup to a different location than the original location
where the backup occurred.

registration The process of establishing an identity with the Avamar server. When Avamar
recognizes the client, it assigns a unique client ID (CID), which it passes back to the
client during client activation.
 
See also client registration

restore An operation that retrieves one or more file systems, directories, files, or data objects
from a backup and writes the data to a designated location.

retention The time setting to automatically delete backups on an Avamar server. Retention can be
set to permanent for backups that should not be deleted from an Avamar server.
Retention is a persistent and reusable Avamar policy that can be named and attached to
multiple groups.

 

S

schedule The ability to control the frequency and the start and end time each day for backups of
clients in a group. A schedule is a persistent and reusable Avamar policy that can be
named and attached to multiple groups.
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subset backup A backup that makes copies of selected databases and files. A subset backup includes
only a few databases that require a backup. For example, a subset backup is appropriate
if a user wants to back up a few databases several times a day to ensure that if an
accidental loss of a mailbox occurs, the user has a current backup of the database.

 

T

transaction logging A process that captures all changes made to a database and writes them to log files.
The Domino server supports three types of transaction logging:

l Circular logging—Reuses the log files and overwrites old transactions. Circular
logging is the default.

l Archive logging—Reuses the log files after they are archived. Archive logging is the
recommended type of transaction logging.

l Linear logging—Reuses the log files and overwrites old transactions for log sizes
greater than 4 GB.

transaction logs Log files used by the Domino server to store all changes made to Lotus databases that
you enable for transaction logging.

 

U

User Account Control
(UAC)

A Windows feature available in Windows Server 2008 R2 and Windows Vista. UAC helps
prevent unauthorized changes to your computer. When functions that could potentially
affect a computer's operation are made, UAC prompts the user for permission or for an
administrator's password before continuing with the task.
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